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1.  INTRODUCTION 
Transparity® Traffic Management System (TMS) is a tool for 
transportation professionals to manage, monitor, and control 
transportation equipment. The benefits of the software are: 

• Create and maintain traffic Controller inventory 

• Upload and download timing parameters 

• View real time operational status and alarms 

• Collect and store traffic Controller logs 

• Review discrepancies between timing records 

• Connect using legacy and standards-compliant communications protocols 

1.1 TRANSPARITY TMS  
Transparity TMS is a 24/7/365 client-server system designed for transportation management 
centers that have full time communications with traffic control equipment. The software consists of 
server components such as services and databases, and client components installed on desktop 
computers connected with the server via a LAN or WAN. A web app is delivered with every services 
installer where the end user can run the on-premise Signal Performance Measures (SPM) reports, 
other reports, and download the desktop Setup.exe. 
 
Transparity has the functionality to allow a desktop client to prompt for updates, down load the 
update and kick off the install. The desktop closes and the installer is able to uninstall the current 
version and install the new version with relative ease. 
 
Migration Synchronization is an additional tool written to help a customer upgrade from their legacy 
central system QuicNet® to Transparity. They convert things like a QuicNet traffic Controller to a 
Transparity traffic Controller, and many other items like detectors, channels, system links, etc. 
Because Transparity was developed to be a drop-in replacement for QuicNet, the migration was 
made straightforward. Thus, the manual effort required to convert to Transparity is much less. 
 
LACO-4E is a protocol in Los Angeles county that is based on the California standard for traffic 
Controller communications: AB3418. This is a California assembly bill introduced before USDOT 
NTCIP 1202 came out. LACO-4E takes AB3418 and adds a couple custom messages. Transparity 
supports these custom extensions. 
. 
McCain, Inc. signs our code (DLL and EXE files) with a code signing certificate. When our software 
is installed, Windows reports, "This has been signed by a verified publisher, McCain, Inc." 

1.1.1 Transparity IMS 
Transparity Intersection Management System (IMS) is a companion product to McCain Omni eX® 
intersection control software and Transparity TMS. It is a self-contained pro- gram that does not 
require a server and is intended for mobile scenarios where personal computers are connected 
directly with traffic Controllers. This product is ideal for agencies without extensive communication 
infrastructures. 
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1.2 TYPES OF DATA 
The key function of a traffic management system is to exchange data with equipment via 
communications channels, displaying data for analysis and editing, and designing responses to 
varying traffic conditions. 
 
There are four classifications of traffic Controller data: 

1.2.1 System Data 
System data resides only in the central system and is not stored or recognized by the software 
running in the equipment. For example, names can be given to phases in Transparity TMS, but 
these names cannot be saved to the traffic Controllers. 

1.2.2 Control Data 
Control data exists in field equipment. It is accessible remotely, via communications channels, or 
locally. It is not typically saved to non-volatile memory in the equipment; therefore, it returns to 
default values after a power interruption. It must be refreshed on a regular basis in order to remain in 
effect, while the specifics of the refresh interval and timeout mechanism vary by program and 
protocol. 
 
An example of control data is the pattern control object in Omni eX software. A Trans- parity TMS 
system can set pattern control to make the traffic Controller run a cycle, split, and offset. The system 
must set pattern control at least once within the Controller’s configured backup period; if more than 
the backup period elapses between sets, perhaps due to a failure of the communications link 
between the system and the traffic Controller, the traffic Controller times out and runs a pattern 
specified by other sources, such as its internal time of day schedule. 

1.2.3 Parameter Data 
Parameter data, like control data, resides in field equipment and can be accessed loc- ally or 
remotely. However, parameter data is saved to non-volatile memory in the equipment and persists 
across power interruptions. An example of parameter data is the Startup Phases object in Omni eX 
software. When the program starts, it reads the value of Startup Phases from the flash memory of 
the traffic Controller and sets the signal indications accordingly. 

1.2.4 Status Data 
Status data is read-only data that resides in field equipment and represents a current state or 
characteristic of the equipment that is subject to frequent change. An example of status data is the 
Phase Status object in Omni eX software: it can be read by Transparity TMS and displayed on a 
diagram of the intersection. The system cannot write to Phase Status since the status of a phase is 
set by the Omni eX software and cannot be changed by another entity. 

1.3 TYPES OF DEVICES 
Transparity TMS can be used to view, edit, store, and retrieve differing types of data for differing 
types of devices. Below is a list of categorized devices supported in Transparity TMS: 
 

• Traffic Controller (Intersection Signal) Programs 

• McCain Omni eX 

• McCain 2033 
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• McCain 233 MC 

• McCain 233 RV 

• McCain 233 ON 

• McCain 750 CF 

• McCain 223 SD 

• McCain 215 (Interval) 

• McCain 215 (Phase) 

• McCain 200 CA 

• Caltrans C8 

• NTCIP 1202 

• AB3418 

• Fourth Dimension D4 

• Cameras and other ITS Devices 

• IP Camera 

• ECcom Device 

• General Device 

• Iteris VRAS Device 

• CCTV Camera - Includes User Interface (UI) that can view the 
feed of a cam- era and for cameras that support the feature, 
allow us to control the pan, tilt, and zoom. 

• Ramp Meter Programs 

• McCain 2042 

• Field Master Programs 

• McCain 245 FM 

• Detector Stations 

• Wavetronix SmartSensor HD 

• Sensys Networks Sensor Zone Group 

• Dynamic Message Signs (DMS) 

• Generic 1203 Sign 
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2.  USER INTERFACE LAYOUT 
• "Customize the Workspace" on page 23. 

• "Understand the Home Menu / Toolbar" on page 24. 

• "Devices & Displays Menu" on page 25. 

• "Timing" on page 25. 

• "Groups" on page 25. 

• "Data Collectors" on page 26. 

• "Map Display" on page 27. 

• "Arterial " on page 27. 

• "Reports" on page 28. 

• "Device Logs" on page 30. 

• "Events" on page 31. 

• "Schedules" on page 32. 

• "Tasks" on page 32. 

• "Channels" on page 33 

• "Alarms" on page 33. 

• "Broadcast Time/Date" on page 33. 

• "Viewing System Devices" on page 35. 

• "Controller Sub-Context Menu" on page 35. 

• "Editing Selected Traffic Controller from Sub-Context Menu" on page 36. 

• "Logging Off" on page 40. 

Transparity TMS is a framework for an advanced set of transportation control modules. Each module 
(or component) is easily accessible via the Transparity interface and edits data in the Transparity 
database. The framework provides a main menu and several dockable workspaces (shown 
below). 
 
Most features open in a primary default workspace upon launch; however, the user may drag a 
window into the workspace of choice and customize the look and feel of the application. 
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Figure 2-1: User Interface Layout 

2.1 CUSTOMIZE THE WORKSPACE 
The Transparity interface allows users to easily customize their screen by dragging and dropping 
displays into the desired workspace area. 

2.1.1 To Customize the Workspace 
1. Open the desired function, such as Web Maps, Messaging, etc. 

The feature will automatically open in the main workspace. 

2. Left click and hold on the desired item and drag it to the desired location. Areas 
shown in yellow above highlight where items may be dropped. 
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Figure 2-2: Customize the Workspace 

2.2 UNDERSTAND THE HOME MENU / TOOLBAR 
The Home tab in the main toolbar located across the top of the application provides quick access to 
primary system functions. 
 
This section provides access to the latest functionality in the Home / Menu Toolbar. 

 

 

Figure 2-3: Main Menu / Toolbar 



Transparity® TMS – User Manual 

Version 1.7.3 Page 25 of 228 

 

 

 

2.2.1 Devices & Displays Menu 

 Figure 2-4: Devices & Displays Menu 

 Timing 
The Timing menu dropdown button opens the following options: 

 

  

FIGURE 2-5: Timing Menu 

 Groups 
Control Groups allow the user to organize traffic Controller inventory for logical or operational reasons. A user 
with appropriate permissions can send operational commands to multiple traffic Controllers at once using control  
groups. 

 

Editor Launches the timing editor 

Archives Create, view, store timing archives 

Templates 
Create pre-configured templates for common 
inter- 

section phasing 

Import Retrieve and store data from external source 

Export Export timing database to controller friendly 
format 

Synchro Data 
Import/Export Synchro supported data format 
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The Groups menu dropdown button opens the following options: 

FIGURE 2-6: Groups Menu 

 Data Collectors 
 

FIGURE 2-7: Data Collectors 

Create Group Allows for the creation of traffic 
con- 

troller groups 

Group Summary Summary of all created traffic 

 

 

Group Timing Editor 

Allows for select coordination 
para- meters to be viewed and 
edited simultaneously for 
controllers in a group Manage 
Coordination parameter across a 
group of controllers 

 

Group Pattern Control 

Allows pattern controls to be sent 
to and visualized for all controllers 

      
  

    

 
Create System 
Detector 

Allows the user to create a system 
detector object for collecting traffic 
data 

in Transparity. 

System Detector 

Summary 
Summary of all created system 
detectors 

Detector Status 

Summary 

Summary of the status of all system 

detectors 

 

Create Speed 
Trap 

Allows the user to create a speed trap 
object for collecting speed data in 
Trans- 

i  
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 Map Display 
  

Figure 2-5: Map Web Display 

 Arterial 
An arterial is a collection of intersections joined by links that can be configured to run a traffic 
responsive profile, traffic adaptive and run time/space diagrams. 
 
The arterial dropdown menu button opens the following options:  

 

Map Web Display 

Opens the web map centered on the 
latitude and longitude defined in 
system 

configuration 

Create Subsystem 

Display 

Allows the user to create Bitmap dis- 

plays 

Subsystem Display 

Summary 
Lists all of the Bitmap displays 
created 

Create GIS Dis  
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Figure 2-6: Arterial Menu 

2.2.2 Reports & Logs 

Menu  
Figure 2-7: Reports & Logs 
Menu 

 Reports 
The data collected and stored by the Transparity SQL central database is neatly displayed using 
modern report and chart controls. Users can choose from a variety of para- meters to customize 

Create System Link Allows creation of links to tie inter- 

sections together 

System Link 
Summary Summary of all created links 

System Link Status 

Summary 
Summary of all created links 

Create Arterial Route 

Movement 
Associated phase/overlap 

Arterial Route 
Movements 
Summary 

Summary of arterial movements 
created 

Arterial Route 
Builder 

A wizard that can be used to 
create 

arterial routes 

Arterial Routes 
Summary Summary of arterial routes 

 

Create Command 
Pro- file 

Allows the user to configure an 
Advanced Adaptive Pattern, Basic 
Adaptive Pattern, or Responsive 
Pat- 

tern Command Profile 

Command Profiles 

Summary 

Summary of all created command 

profiles 

Command Profile 
Dis- 

play 

Shows History of actions of Traffic 

Responsive Operations 

 

Time-Space 
Diagram 

Shows status of intersections 
within a route on a chart, plotting 
green times for the specified 
movements in 

green bands over a defined 
period 
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general reports and add agency logos or other information to report headers. Each report can be 
exported in a variety of common formats. While users can customize the content of reports, the 
general layout is based on industry standards. 

 

Most reports have date range restrictions to avoid too wide a time frame. This limits big performance 
hits on the report and potentially, the rest of the system. Sometimes the restriction is a day, 
sometimes more or less, depending on what is useful and acceptable to the report. 
 
The Reports dropdown menu opens the following options:  

 

 

Figure 2-8: Reports Menu

 

Split MOE 

Displays the duration of green 
for each phase per cycle in 
addition to 

the reason for phase termination 

 

System Detector 
VOS 

Displays system detector VOS 
data via a chart and table of 
values recorded by the system 

Link Detector VOS 
Displays VOS data collected by 
the 

system 

Speed Trap 
Displays speed data collected by 
the 

system 

Turning 
Movement Count 

Detector counts for whatever 
period selected 

Peak Hour 
Peak Hour Detector counts during 

specific hours of the day 

Blue TOAD Travel 

Time 

Displays link status data retrieved 

from BlueTOAD 
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 Device Logs 
Device logs are logs generated by and stored on the Controller. These can be uploaded by 
Transparity TMS, either on demand or on a schedule, for historical purposes. The logs available 
differ per Controller type. 
 
The Device Logs dropdown menu button opens the following options: 

 

  

 

Figure 2-9: Device Logs Menu 

All Activity All activity in the system, including 
field and user operations 

User Activity 
All activity in the system, including 
field and user operations 

Schedule Activity 
Displays all Transparity Scheduling 
activity 

Alarm Activity Displays all Transparity 
Alarm activity 

Operation Activity 
Displays all Operating Mode 
changes to devices 

Comm Error 
Shows communication error rates 
between central and the field 

 

Traffic Controller MOE 

Shows method of efficiently 
dis- playing data, including cycle 
and split lengths 

Traffic Controller 
Displays all operational functions 
at the selected intersection 

Detector Speed 
Shows collected speed data from 
detectors 

Detector VOS 
Shows collected VOS data from 
detectors 

Command Profile A log of all commands entered 
on the Transparity TMS system 

 

Command Threshold 

A log of all command threshold 
events encountered during a 
Traffic Responsive or Advanced 
Adaptive operation 
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2.2.3 Management Menu 

 Figure 2-10: Management Menu 

 Events 
The Events dropdown menu button opens the following options: 

 

Figure 2-11: Events Menu 

Create 
Event 
Notification 

Allows user to set 
notification preferences 

Event Notification 

Summary 
Summary of all notifications 

Unacknowledged 
Events Events not yet acknowledged 

Create Regional 
Event Create new regional event 

Regional Event 
Summary Summary of all regional events. 
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 Schedules 
The Schedules dropdown menu button opens the following options: 

 

Figure 2-12: Schedules Menu 

 Tasks 
The Tasks dropdown menu button opens the following options: 

Figure 2-13: Tasks Menu 

 

Create Schedule 

Schedule traffic routines, 
operational commands, and data 
collection 

Schedule Summary Summary of created schedules 

Set Pattern 
Schedules 

Summary of all Set Pattern 
schedules 

Command Profile 
Schedules 

Summary of all Command Profile 
schedules 

Device Time Sched- 
ules 

Summary of all 
Broadcast Time/Date 
schedules 

Retrieve Controller 
Log Schedules 

Summary of all controller log 
upload schedules 

System Schedules Summary of all system schedules 

 

Create Task Create tasks to assign to users 

Task Summary Summary of created tasks 

 

Upcoming Tasks 

Window at the bottom of the 
screen shows tasks that are 
overdue or not completed. 
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2.2.4 Communications Menu 

Figure 2-14: Communications Menu 

 Channels 
The Channels dropdown menu button opens the following options: 

 

    Figure 2-15: Channels Menu 

 Alarms 
By selecting the Alarms button, users can view all the currently active Alarms in a Summary format: 

 
Figure 2-16: Alarms Menu 

 Broadcast Time/Date 
By selecting the Broadcast Time/Date button, users can update the time and date of user selected 
traffic Controllers. 

 

Figure 2-17: Broadcast Time / Date 

Create Channel Where communication channels 
are set up 

Channel Summary Summary of all added channels 
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2.3 VIEWING SYSTEM DEVICES 
By default, a list of system-wide traffic devices is shown on the left side of the screen. The Traffic 
Devices list is an active menu of devices and system objects. Device status is updated by polling 
the Transparity server. Using the split button  users can launch a device’s sub-context menu 
specific functions or logs. 

 

Figure 2-18: Traffic Devices List 

2.3.1 Browsable Devices 
Expand for a snapshot of the device properties and quick access to object configuration. 

2.3.2 Detector Stations 
Expand for a list of detectors and quick access to system detector configuration. 

2.3.3 Field Masters 
Expand for a list of field masters and quick access to edit their configuration. 

2.3.4 Ramp Controllers 
Expand for a snapshot of all ramp Controllers and quick access to edit their configuration. 

2.3.5 Sign Controllers 
Expand for a snapshot of all signs and quick access to edit their configuration. 

2.3.6 Traffic Controllers 
Expand for a list of all traffic Controllers in the system. Colored dots to the left of the con- troller name 
indicate the operational status of the intersection. 

 

Right-click on the desired Controller to open the Controller Sub-Context menu (detailed in the next 
section) which provides quick access to additional functions. 
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2.4 CONTROLLER SUB-CONTEXT MENU 
The Controller Sub-Context Menu displays a list of functions specific to the intersection of the 
selected device. 

2.4.1 Traffic Controller Menu 
1. To access the menu: 

Device Explorer Menu > Traffic Controllers Dropdown Menu 

 
Figure 2-19: Access the Controller Sub-Context Menu  

2. Right-click on the desired Controller. 

3. Once a Controller is selected the following options are available: 
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Topic   Expanded       

Notes Add Note View All 

Resources Add Reference View All 

 

Logs 

 

Activity 

Traffic 
Con- 
troller 
MOE 

Traffic 
Con- 
troller 

Directo
r 
Speed 

Directo
r VOS 

Device Information  

 

Displays 

  

Suitcase 

  

Aerial 
Phase 

Diagram 
Display 

Map 
Web 

Displa
y 

Timing Editor  

 

Operations 

 

Broadcast 
Time/Date 

Signal 
Pattern 
Control 

Turn 
COM

M 

Debu
g On 

Turn 
COM

M 

Debug 
Off 

Browsable 
Devices 

 

Figure 2-20: Controller Sub-Context Menu 

2.4 EDITING SELECTED TRAFFIC CONTROLLER FROM SUB-CON 
TEXT MENU 
1. Select Home > Devices >Device List. 

2. Expand  Traffic Controllers group. 

3. Select the expansion arrow on the right side of a Traffic Controller 
name (See  expansion arrow in graphic) to launch the Traffic 
Controller’s Sub-Context Menu. 

4. Select the Edit (Selected) Traffic Controller in the Sub-Context Menu. 
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Figure 2-21: Edit Selected Controller from Sub-Context Menu 

2.4.1 General 
Table 2-1: Create Traffic Controller – General 

Name Assign a Unique name identifying the traffic Controller 

Version • 1.4 or 

• 1.7 

Protocol NTCIP (non-selectable field) 

System Id The System Id assigned to the traffic Controller 

Tru-Traffic 
Id 

The Tru-Traffic Id assigned to the traffic Controller 

Description Non-mandatory description of the traffic Controller 

Inactive A check mark in this box will cause the traffic Controller to be created in an inactive 
state. 

2.4.2 Communication 
Table 2-2: Create Traffic Controller – Communication 

Channel Select the Traffic Controller Device type (i.e. McCain Omni eX). 

Drop 
Address 

A unique number that identifies a serial card in a traffic Controller Transparity is 
communicating with. 
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Area 

Number 

A number that further refines the addressing information used by Transparity for 
communicating to a traffic Controller that communicates via a serial connection. 

Area 

Address 

A number that further refines the addressing information used by Transparity for 
communicating to a traffic Controller that communicates via a serial connection. 

IP 
Address 

The IP protocol address assigned to the traffic Controller 

IP Port PC port used to communicate with the IP protocol 

 

2.4.3 Location 
Table 2-3: Create Traffic Controller – Location 

Latitude The Latitude location of the traffic 
Controller 

Longitude The Longitude location of the traffic 
Controller 

Main Street The primary arterial 

Cross 
Street 

A cross street on a primary arterial 

2.4.4 Hardware 
Table 2-4: Create Traffic Controller – Hardware 

Hardware Make This is the name of the manufacturer that makes the traffic 
Controller 

Reported 
Version 

This is the Firmware version running on the traffic Controller 

Hardware Model This represents the hardware version for the traffic Controller 

Cabinet Type This represents the type of cabinet housing the traffic Controller 

2.4.5 Configuration 
Table 2-5: Create Traffic Controller – Configuration 

Active Phases The number of phases provisioned 

Active Overlaps The number of overlaps provisioned 

Active Detectors The number of detectors provisioned 
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Active Patterns The number of patterns provisioned 

Active Schedules The number of schedules provisioned 

Active Splits The number of splits provisioned 

Active Time base 
Actions 

The number of active time base actions 
provisioned 

2.4.6 Labels 
Table 2-6: Create Traffic Controller – Labels 

Detector 
This interface is used to assign label names to detectors. (1 through 32) 

 

 

 

 

 

Phase 

This interface is used to assign predefined label names to phases. (1 through 8) 

• NB/L 

• NB 

• NB/R 

• EB/L 

• EB 

• EB/R 

• SB/L 

• SB 

• SB/R 

• WB/L 

• WB 

WB/R 

 

 

 

 

 
Preempt 

This interface is used to assign new or predefined label names to preempts. (1 
through 9) 

Predefined names: 

• EV-A 

• EV-B 

• EV-C 

• EV-D 

• RR-1 

• RR-2 
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• SE-1 

• SE-2 

• RR-3 

 

2.4.7 Advanced 
Table 2-7: Create Traffic Controller - Advanced 

 

 

 

 

Poll 
Interval 

This interface is used to assign a predefined poll interval. Poll intervals available for 
selection are: 

• 1 second 

• 2 seconds 

• 3 seconds 

• 5 seconds 

• 10 seconds 

• 15 seconds 

• 30 seconds 

• 60 seconds 

Transit 
Logs 

This interface is used to check a box that states: 

• Has Transit Logs 

2.5 LOGGING OFF 
2.5.1 End the Transparity session 

a. Click the Settings icon. 

 

Figure 2-22: Settings Icon 
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Figure 2-23: Exit the Session 

b. Click Exit.
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3.  MANAGE DEVICE AND CONNECTIONS 
This section provides an overview of: 
 

• "Create a Communications Channel:" below. 

• "Create a Traffic Controller" on page 45. 

• "Create a Control Group" on page 73. 

• "Browsable Devices" on page 59. 

• "Create a Detector " on page 62. 

• "System Links" on page 69. 

3.1 COMMUNICATION CHANNELS 
Transparity TMS uses communication channels to represent physical channels and allow for 
custom latency toleration settings. Polling is accomplished by each virtual channel independently of 
each other, and it is recommended to keep the number of Controllers assigned to any one UDP 
channel low. 

3.1.1 Create a Communications Channel: 
1. Select Communications >Channels > Create Channel. 

 

Figure 3-1: Create Communications Channel 

2. Complete the fields in Channel Properties (see table "Channel Properties" 
below). 
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3. Click Save once all required fields are completed. 

3.1.2 Channel Properties 
Table 3-1: Channel Properties 

Name Insert a descriptive name for the channel 

 

First Byte 
Time 

The amount of time in milliseconds that the field communications processor will 
allow for messages to be sent back and forth from field devices. Increasing this 
value will increase the amount of time for messages to be sent across and can be 
useful in low bandwidth or poor communication environments (1200 baud, outdated 
copper, etc.). 

This is generally left at default for UDP communications. 

Baud Rate 
The rate of bits per second being sent when utilizing a serial connection. This ranges 
from 1200 to 115,200 baud and must match the setting at the Controller. 

Stop Bits This value determines the number of bits sent to end a message when Serial is 
selected. Typically left at 1. 

 

Type 

Serial will show all available COM (communications) ports attached to the 
computer. For UDP this box becomes an open value field where the input can 
be any number from 8001 to 9999. This number specifies the UDP port that will 
be utilized to communicate with field devices. 

 

Parity 

When Serial is selected as the Type, the user has the option of odd, even, or none in 
the Parity field. A parity bit, or check bit is a bit added to the end of a string of 
binary code that indicates whether the number of bits in the string with the value one 
is even or odd. Parity bits are used as the simplest form of error detecting code. 

 

3.1.3 View Channel Summary 
1. To view a channel summary, select Channel > Channel Summary. 

Figure 3-2: Create Communications Channel 

2. A channel window will open in the main workspace. 

3. Double-click on the desired channel row to open the Edit Channel function. 
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Figure 3-3: Edit Channel 

4. Click on the Show Detail button to open the box containing the channel detail. 

 

    Figure 3-4: Viewing Channel Details 

It is possible to drag and drop columns to reorder them in every Summary list view. It is also possible 
to hide and show columns. An action shot of drag/drop column reordering is shown below. 
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Figure 3-5: Example of Column Reordering 

Right clicking on any column in the header gives you a content menu with all possible columns. The 
ones with a checkbox mean they are already visible. In this way, you can hide and show columns in a 
list. 

 

 

Figure 3-6: Hiding/Showing Columns 

3.2 TRAFFIC CONTROLLERS 
3.2.1 Create a Traffic Controller 

Local Controllers are the heart of every traffic management system. The local Controller implements 
core functionality including intersection timing, coordination, and preemption. Configuring 
Controllers in Transparity TMS allows them to be remotely controlled, viewed, and accessed via the 
central system. 
 
Transparity has an additional feature which allows you to create new items in item selectors if what 
you want doesn't exist. For example, you may want to create a Traffic Controller and add it to a 
channel, but that channel doesn't exist, or perhaps you want it on its own dedicated channel. When 
you open the item selector to select the channel, there is a Create button that allows you to do it on 
the fly. There are many item selectors in the system, on Detectors, Ramp Controllers, and Field 
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Masters. Almost anything that can be associated with another object will have this same functionality. 
 
For example, when you create a System Detector you must associate it to a Traffic Controller. On 
its item selector, you have the ability to Create a new Traffic Controller right there. 
 

 
 

  Figure 3-7: Create Traffic Controller 

1. Select Device Explorer > Traffic Controllers > Create Traffic Controller. 

2. Complete the Traffic Controller Properties using the table shown below: 
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Figure 3-8: Complete Traffic Controller Properties 

3. All fields with a red dot require completion. 

4. Click Finish. 

 

3.2.2 Traffic Controller Properties 

 Device 
Device Name Select the Traffic Controller Device type (i.e. McCain Omni eX) 

 General 
Table 3-2: Create Traffic Controller - General 

 
Version 

• 1.4 or 

• 1.7 

NOTE: Versions are sub-functions of Controller type and options change 
based on type selection. 

Protocol NTCIP (non-selectable field) 

System Id The System Id assigned to the traffic Controller 

Tru-Traffic Id The Tru-Traffic Id assigned to the traffic Controller 

Description Non-mandatory description of the traffic Controller 
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Inactive 

A check mark in this box will cause the traffic Controller to be created 
in an inactive state. No communication will be attempted to the device 
while inactive 

 Communication 
Table 3-3: Create Traffic Controller - Communication 

Channel Select a channel to communicate to this device. 

Drop Address 
A unique number that identifies a serial card in a traffic Controller that 
Transparity is communicating with. 

 

Area Number 

A number that further refines the addressing information used by 
Transparity for communicating to a traffic Controller that communicates 
via a serial connection 

 

Area Address 

A number that further refines the addressing information used by 
Transparity for communicating to a traffic Controller that communicates 
via a serial connection. 

IP Address The IP protocol address assigned to the traffic Controller 

IP Port PC port used to communicate with the IP protocol 

 Location 
Table 3-4: Create Traffic Controller - Location 

Latitude The Latitude location of the traffic Controller 

Longitude The Longitude location of the traffic Controller 

Main Street The primary arterial 

Cross Street A cross street on a primary arterial 

 Hardware 
Table 3-5: Create Traffic Controller – Hardware 

Hardware Make This is the name of the manufacturer that makes the traffic Controller 

Reported Version This is the Firmware version running on the traffic Controller 

Hardware Model This represents the hardware version for the traffic Controller 

Cabinet Type This represents the type of cabinet housing the traffic Controller 
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 Configuration 
Table 3-6: Create Traffic Controller – Configuration 

Active Phases The number of phases provisioned 

Active Overlaps The number of overlaps provisioned 

Active Detectors The number of detectors provisioned 

Active Patterns The number of patterns provisioned 

Active Schedules The number of schedules provisioned 

Active Splits The number of splits provisioned 

Active Time base 
Actions 

The number of active time base actions provisioned 

 Labels 
Table 3-7: Create Traffic Controller – Labels 

Detector This interface is used to assign label names to detectors. (1 through 32) 

 

 

 

 

 

Overlap 

This interface is used to assign predefined label names to overlaps. (1 through 
8) 

• NB/L 

• NB 

• NB/R 

• EB/L 

• EB 

• EB/R 

• SB/L 

• SB 

• SB/R 

• WB/L 

 
Phase 

This interface is used to assign predefined label names to phases. (1 through 
8) 

• NB/L 

• NB 

• NB/R 

• EB/L 
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• EB 

• EB/R 

• SB/L 

• SB 

• SB/R 

• WB/L 

• WB 

• WB/R 

 

 
Preempt 
 

  

This interface is used to assign new or predefined label names to preempts. 
(1 through 9) Predefined names: 

• EV-A 

• EV-B 

• EV-C 

• EV-D 

• RR-1 

• RR-2 

• SE-1 

• SE-2 

• RR-3 

 

 Advanced 
Table 3-8: Create Traffic Controller 

 

 

 

 
Poll Interval 

This interface is used to assign a predefined poll interval. Poll intervals 
available for selection are: 

• 1 second 

• 2 seconds 

• 3 seconds 

• 5 seconds 

• 10 seconds 

• 15 seconds 

• 30 seconds 

• 60 seconds 
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Transit Logs This interface is used to check a box that states: 

• Has Transit Logs 

3.2.3 Edit a Traffic Controller 
1. To edit a traffic Controller, select Device Explorer > Traffic Controllers. 

2. Click the Edit Traffic Controller  button. 

3. The Edit Traffic Controller Properties window will open allowing the user to 
make changes to any of the Controller settings. 

4. The ability to migrate timing between Omni versions is triggered by Change 
Version in the Controller's edit page. So, if you are upgrading from Omni 1.11 to 
Omni 2.0, you Change Version and the backend will upgrade the timing 
conversions to add the new items for Omni 2.0 timing. 

 

Figure 3-9: Change Device Version 
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Figure 3-10: Edit Traffic Controller 

1. Click Save once changes have been made. 

3.2.4 Delete a Traffic Controller 
1. Select Device Explorer > Traffic Controllers. 

2. Click the Edit Traffic Controller  button. 

3. Click Delete. 

4. Click Yes to proceed with the deletion. 

3.2.5 Create a Phase Diagram Display 
Use the Phase Diagram Display to create a visual representation of the phase sequencing and 
directionality per intersection. This visualization can also be included in Aerial Displays or on the first 
page of the printed timing sheets for a McCain Omni eX traffic control program. Some elements of 
configuration will be familiar to a user who has created Aerial Displays in Transparity TMS. 

1. Open the Phase Diagram Display: Display > Phase Diagram Display. 

2. Navigate to the context menu for a traffic Controller to create, view, or edit. 
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Figure 3-11: Phase Diagram Display on a Traffic Controller 

 

Figure 3-12: Phase Diagram Display 
The default display will issue a standard eight phase, two ring, lead-lead sequence diagram. 
 
Users can edit each of the elements of the display including: Rings, North Arrow, Phase Movement, 
Pedestrian Movement, and Generic customizable labels. 

3.2.6 Traffic Controller Summary 
The Traffic Controller Summary provides users with a list of previously configured Traffic Controllers 
where users can quickly review the properties of the Traffic Controllers, sort and filter the list, or 
Create, Edit, and Delete Traffic Controllers. 

3.2.7 Traffic Controller Status Summary 
The Traffic Controller Status Summary updates each minute and displays the real-time value of 
Traffic Controller in the list. 
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3.3 FIELD MASTERS 
3.3.1 Create a Field Master 

A Field Master has one or more Traffic Controllers connected to it. Each traffic Controller connected 
to a field master uses it for all of communications with Transparity TMS. 

 

Figure 3-13: Create a Field Master 

 
Figure 3-14: Create a Field Master 2 

1. Select: Device Explorer > Field Master > Create Field Master. 

2. Complete the Field Master Properties using the table at Create 
a Field Master                        above. 

3. Click Finish after completion. 
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3.3.2 Field Master Properties 

 General 
Table 3-9: Create Field Master - General 

Name Populate the Type field with McCain 245FM 

Version 
Hardware make, model, firmware version and cabinet type (selectable from a 
dropdown list). 

 

 

 

Protocol 

Channel, IP information, and area fields for serial device communications. 

• Select a channel by clicking on the file folder button 

• Be sure the IP address matches the IP address of the Controller in the field 

• Select the appropriate Field Master to populate the Field Master field 

• Populate Dial Number field if a Field Master’s connection will be via 
analog Check the box titled: “Use PBX Dial out Access Code” followed by 
the code access number if dialing out through a PBX is necessary (via 
modem) 

System Id 
Latitude and longitude of the traffic Controller, which ensures the device will 
appear on the system map. You may also add the device’s street location. 

Description 
Configuration settings vary depending on the type of Controller. buttons are 
greyed out if they are not applicable to the selected device type 

Inactive 
A check mark in this box will cause the traffic Controller to be created in an 
inactive state. No communication will be attempted to the device while 
inactive 

 Communication 
Table 3-10: Create Field Master – Communication 

Channel Select a channel to communicate to this device. 

Drop Address 
A unique number that identifies a serial card in a traffic Controller Transparity 
is communicating with. 

Area Number 
A number that further refines the addressing information used by Transparity 
for communicating to a traffic Controller that communicates via a serial 
connection. 

Area Address 
A number that further refines the addressing information used by Transparity 
for communicating to a traffic Controller that communicates via a serial 
connection. 

IP Address The IP protocol address assigned to the traffic Controller. This is only 
necessary when Channel type is UDP. 
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IP Port PC port used to communicate with the IP protocol 

 Location 
Table 3-11: Create Field Master – Location 

Latitude Populate the Type field with McCain 245FM 

Longitude 
Hardware make, model, firmware version and cabinet type (selectable from 
a dropdown list). 

Main Street Channel, IP information, and area fields for serial device communications. 

• Select a channel by clicking on the file folder button  

• Be sure the IP address matches the IP address of the Controller in 
the field 

• Select the appropriate Field Master to populate the Field Master field 

• Populate Dial Number field if a Field Master’s connection will be via 
analog. Check the box titled: “Use PBX Dial out Access Code” 
followed by the access code number if dialing out through a PBX is 
necessary (via modem) 

Cross Street 
Latitude and longitude of the traffic Controller, which ensures the device will 
appear on the system map. You may also add the device’s street location. 

 

 Hardware 
Table 3-12: Create Field Master - Hardware 

Hardware Make Populate the Type field with McCain 245FM 

Reported Version Hardware make, model, firmware version and cabinet type (selectable 
from a dropdown list). 

 

 

 

 

Hardware Model 

Channel, IP information, and area fields for serial device communications. 
• Select a channel by clicking on the file folder button 

• Be sure the IP address matches the IP address of the Controller in 
the field 

• Select the appropriate Field Master to populate the Field Master 
field 

• Populate Dial Number field if a Field Master’s connection will be 
via analog Check the box titled: “Use PBX Dial out Access Code” 
followed by the access code number if dialing out through a PBX is 
necessary (via modem) 

Cabinet Type 
Latitude and longitude of the traffic Controller, which ensures the device 
will appear on the system map. You may also add the device’s street 
location. 
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3.3.3 Field Master Summary 
The Field Master Summary provides users with a list of previously configured Field Masters 
where users can quickly review the properties of the Field Master, sort and filter the list, or Create, 
Edit, and Delete Field Masters. 

3.3.4 Field Master Status Summary 
The Field Master Status Summary updates each minute and displays the real-time  value of Field 
Masters in the list. 

3.4 DETECTOR STATIONS 
Detector volume, occupancy, and speed (VOS) data is traditionally collected from the detector 
objects of local Controller software (i.e. Controller system detectors); however, many municipalities 
collect traffic data from systems disjointed from the traffic Controller inputs. 
 
In order to collect VOS data from an external device or system, the user must first configure a 
detector station. The detector station represents the device that is collecting VOS data from zones 
or lanes. Upon configuration of the detector station, users can create system detectors affiliated with 
the detector station in order to discriminate the data collected by the detector station into zones or 
lanes. 
 
Transparity TMS natively communicates with the Wavetronix SmartSensor HD detector station. It 
can also integrate with Sensys Networks’ SNAPS servers for collection of detector data. 

3.4.1 Create a Wavetronics SmartSensor HD 
1. Select: Device Explorer > Detector Stations > Device List > Create Detector 

Station. 
2. Click the Add button on the Detector Stations menu. 

 

Figure 3-15: Create a Detector Station 

1. Select Wavetronics SmartSensor HD on the device page of 
the configuration wizard. 
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2. Complete the Detector Station Properties at Step "Wavetronix SmartSensor HD 
Properties" on the next page. All fields with red dots require completion. 

 

Figure 3-16: Complete Detector Properties 

3. Click Finish once all the required fields are completed. 

3.4.2 Wavetronix SmartSensor HD Properties 

 General 
Table 3-13: Detector Properties - General 

Name Enter the Detector Station Name 

Description Additional space to bolster the name of the Browsable Device 

Inactive Disable collection from this detector station 

 Communication 
Table 3-14: Detector Properties - Communication 

Channel Select a channel to communicate to this device 

Subnet The WaveTronix SmartSensor HD subnet 

Station Id The WaveTronix SmartSensor HD identifier 

IP Address The IP protocol address assigned to the traffic Controller 

IP Port PC port used to communicate with the IP protocol 
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 Location 
Table 3-15: Detector Properties - Location 

Latitude The Latitudinal location of the Browsable Device. 

Longitude The Longitudinal location of the Browsable Device. 

Main Street The primary arterial. 

Cross Street The cross street on a primary arterial. 

3.5 BROWSABLE DEVICES 
Browsable Devices are device types that provide users with functionality via the browser interface 
of the device. With Browsable Devices the user can launch displays for: general webpages, 
CCTV Cameras, RTSP Streams, Video Detection Cameras, and Conflict Monitors. 

3.5.1 Browsable Device Properties 
Table 3-16: Browsable Device Properties 

Name Enter the Browsable Device Name. 

 
Type 

• General Device 

• IP Camera 

• ECcom device 

• Iteris VRIS Device 

Description Additional space to bolster the name of the Browsable Device 

Associated Device 
The Browsable Device will appear in popup menus for that traffic 
Controller if you select a traffic Controller in the Associated Controller 
field. 

Latitude The Latitudinal location of the Browsable Device. 

Longitude The Longitudinal location of the Browsable Device. 

Address The address where the Browsable Device is located 

Browse to Device button that allows the user to Browse to the Device 

3.5.2 Create a Browsable Device – General Device 
1. Select: Devices Explorer > Browsable Devices > Create Browsable Device. 



Transparity® TMS Manual 

Version 1.7.3 

Page 60 of 228 

 

 

 

 

 

 

Figure 3-17: Create Browsable Device 

2. Select General Device. 

3. Click Next. 

4. Provide a common Name for the device or webpage or 
associate the device/webpage with a Traffic Controller, and 
optionally provide a Description. 

5. Click Next. 

6. Specify the Address (i.e. URL of the webpage). 

7. Specify the Latitude and Longitude for inclusion of the device on the system 
map. (Main Street / Cross Street are optional text fields). 

8. Click Finish. 

3.5.3 Create a Browsable Device – CCTV Camera 
1. Select CCTV Camera. 

2. Click Next. 

a. If the Video Management System properties have not been configured in: 

Options > External Systems > Video Management 
System, then the. CCTV Camera option will be greyed out. 

3. Define the Name and Description of the Camera (i.e. Main St. @ 3rd. Ave WB). 

4. Choose an Associated traffic Controller (optional). 

5. Select the appropriate camera from the Camera dropdown menu. 
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a. Confirm that the camera has been discovered by the 
Video Management                          System if the camera of interest does 
not appear in the list. 

b. Select a camera from the list (the IP of the camera can be confirmed via the 
Camera Information once selected). 

6. Specify the Latitude and Longitude for inclusion of the device on 
the system map (Main Street / Cross Street are optional text fields). 

7. Click Finish. 

3.5.4 Create a Browsable Device – ECcom Device 
1. Select ECcom Device. 

2. Click Next. 

3. Provide a common Name for the device or webpage or 
associate the device/webpage with a Traffic Controller, and 
optionally provide a Description. 

4. Click Next. 

5. Specify the IP Address of the Conflict Monitor. 

6. Specify the Latitude and Longitude for inclusion of the device on 
the system map (Main Street / Cross Street are optional text fields). 

7. Click Finish. 

3.5.5 Create a Browsable Device – IP Camera 
1. Select IP Camera. 

2. Click Next. 

3. Provide a common Name for the device or webpage or 
associate the device/webpage with a Traffic Controller, and 
optionally provide a Description. 

4. Click Next. 

5. Specify the RTSP URL of the IP Camera. 

6. Specify the Latitude and Longitude for inclusion of the device on 
the system map (Main Street / Cross Street are optional text fields). 

7. Click Finish. 

3.5.6 Create a Browsable Device – Iteris VRAS Device 
1. Select Iteris VRAS Device. 
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2. Click Next. 

3. Provide a common Name for the device or webpage or associate the 
device/webpage with a Traffic Controller, and optionally provide a Description. 

4. Click Next. 

5. Specify the IP Address and IP Port of the Video Detection Processor. 

6. Specify the Latitude and Longitude for inclusion of the device on 
the system map (Main Street / Cross Street are optional text fields). 

7. Click Finish. 

3.6 DETECTORS AND SPEED TRAPS 
Transparity TMS allows users to collect traffic data from both detectors and speed traps. A detector 
or sensor is typically a single point or zone that is monitored by one of many methods, from inductive 
loop, video, ultrasonics, or collecting traffic data. A speed trap is typically two detectors used in 
concert to collect more accurate speed readings than a single detector can provide. 

3.6.1 Create a Detector 
Before proceeding, ensure the following has been completed, as required: 

• "Create a Traffic Controller" on page 45. 

• "Create a Detector " on page 62. 

Configuring detectors enables the system to collect data such as speed, occupancy, and volume. 
Collected data can then be used for the following: 

• Traffic responsive coordination. 

• Adaptive coordination. 

• Congestion level monitoring. 

1. Select: Device Explorer > Detector Stations. 
 

Figure 3-18: Create a Detector 

2. Complete the Detector Properties (see "Detector Properties" 
below). All fields with red dots require completion. 
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Figure 3-19: Complete Detector Properties 

3. Click Finish once all the required fields are complete. 

3.6.2 Detector Properties 
Table 3-17: Detector Properties 

Name A method to identify a detector and potentially what intersection and lane 
it resides in. 

Type Select the type of detector. 

Controller Detector – Detectors that support traffic Controllers 

Description The description can be used to augment existing descriptor-type fields 
such as “Detector Name” and “Controller Name.” 

 

Controller 

Pairs the detector with a traffic Controller. The detector and traffic 
Controller selected are usually found at the same intersection and share a 
parent/child relationship whereby the detector is the child. 

Detector Select a detector number from a dropdown list. The number of detectors 
may be dependent on the type of Controller you selected 

Disabled 
Checking this box prevents the system from polling the Controller or 
device for VOS data. A disabled detector is used for reference in SPM 
reports. 
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General 

This area contains general configuration information for the new detector. 
Information includes: 

• Movement - The selectable type of movement through a lane.  

o Right - for right turn movement 

o  Left - for left turn movement 

o Through – for through movement 

• Direction – Dropdown used to designate the direction of the traffic 
flow  in the lane the detector is located in. (i.e. north, southwest, 
east, etc.) 

• Detector Type – Dropdown allowing the user to select the type of 
detector (i.e. inductive-loop, video-image, etc.). 

• Vehicle Length - Default Value=17 (feet) 

• Loop Length - Default value = 6 (feet) 

 

 

 

 

 

Threshold 

Threshold This area contains high and low limit thresholds for volume 
(vph), occupancy (%) and Speed (mph) 

• Volume (vph) - Volume threshold boundaries 

• High Limit = 2000 (Default Value) 

• Low Limit = 0 (Default Value) 

• Occupancy (%) - Occupancy (%) threshold 
boundaries o High Limit = 100 (Default Value) 

• Low Limit = 0 (Default Value) 

•  Speed (mph) - Speed threshold boundaries 

•  High Limit = 150 (Default Value) 

•  Low Limit = 0 (Default Value) 

 

3.7 CREATE A SPEED TRAP 
In conjunction with McCain Omni eX® traffic Controller software, Transparity TMS uniquely collects 
real-time speed from the NTCIP speed traps. 

3.7.1 Configure a Speed Trap 
Configuring speed traps enables the system to collect real-time speed data from the traffic Controller 
software. This data can be visualized in reports and utilized as a link data source for speed. 
 

1. Select: Data Collectors > Create Speed Trap. 

 



Transparity® TMS Manual 

Version 1.7.3 

Page 65 of 228 

 

 

 

 

 
  Figure 3-20: Create Speed Trap 

2. Provide the general information necessary to identify the speed 
trap and collect data: 

a. Provide a common Name for the Speed Trap (i.e. Approach Intersection 
and Lane Number). 

b. Select the Controller from which the Speed Trap data will be collected. 

c. Select the Speed Trap number that corresponds with 
the Speed Trap number of the Controller. 

d. Provide additional descriptive information about the location and 
configuration of the Speed Trap in the Description field (optional). 
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e. Ensure the Disabled checkbox is empty to guarantee the 
system will collect real-time data.

 

Figure 3-21: Create Speed Trap 

f. Click Next. 

3. Provide the location properties of the Speed Trap: 

a. Enter the Latitude. 

b. Enter the Longitude. 

c. Click Next. 
 

 

Figure 3-22: Enter Latitude and Longitude of Speed Trap 
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4. Provide essential configuration data. This information is critical from 
identification of the Speed Trap in reports and data sharing between 
systems. 

a. Select the appropriate Movement. 

b. Select the appropriate Direction. 

c. Choose a Sensor Type from the dropdown list. 

d. Identify the Lane Number of the Speed Trap. 

 
Figure 3-23: Identify Lane Number of Speed Trap 

e. Click Finish. 

3.7.2 Edit a Speed Trap 
1. Select: Data Collectors > Speed Trap Summary. 

 Configured Speed Traps can be reviewed within the Speed Trap Summary. 

2. Edit an existing Speed Trap: 

a. Select the subject Speed Trap from the Speed Trap Summary. 

b. Click the Edit button. 

 OR 
a. Right Click the subject Speed Trap. 

b. Select Edit. 

3.7.3 Delete a Speed Trap 
1. Select: Data Collectors > Speed Trap Summary. 

Configured Speed Traps can be reviewed within the Speed Trap Summary. 

2. Delete an existing Speed Trap: 
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a. Select the subject Speed Trap from the Speed Trap Summary. 

b. Click the Delete button. 

 OR 
a. Right Click the subject Speed Trap. 

b. Select Delete. 

c. Select Yes to confirm the deletion. 

3.7.4 Speed Trap Properties 
TABLE 3-18: Speed Trap Properties 

Name A method to identify the speed trap location (i.e. Approach Intersection 
and Lane Number). 

 

Controller 

Pairs the detector with a traffic Controller. The detector and traffic 
Controller selected are usually found at the same intersection and share 
a parent/child relationship whereby the detector is the child. 

Speed Trap # 
This value shall match the corresponding Speed Trap # of the traffic 
Controller software (which collects and distributes the real-time speed). 

Description 
The description can be used to augment existing descriptor-type fields 
such as “Detector Name” and “Controller Name.” 

Disabled When selected, Transparity TMS will not actively collect real-time data 
from the subject Speed Trap. 

Latitude Latitude location of the Speed Trap. 

Longitude Longitude location of the Speed Trap. 

Movement Use to identify the movement of the lane where the Speed Trap is 
located. 

Direction Use to identify the cardinal direction of the Speed Trap movement. 

Sensor Type 
Provides informative information regarding the underlying detection 
technology of the Speed Trap. 

Lane Number Identifies the lane number where the Speed Trap is located. 

3.7.5 Speed Trap Summary 
The Speed Trap Summary provides users with a list of previously configured Speed Traps where 
users can quickly review the properties of the Speed Traps, sort and filter the list, or Create, Edit, and 
Delete Speed Traps. 

3.7.6 Speed Trap Status Summary 
Status summaries are additional UI views, such as lists with multiple columns in which the columns 
are all defaulted to status data. 



Transparity® TMS Manual 

Version 1.7.3 

Page 69 of 228 

 

 

 

 

 
The Speed Trap Status Summary updates each minute and displays the real-time value of Speed 
Trap in the list. 

3.7.7 Speed Trap Report 
The Speed Trap Report enables the user to graphically visualize the speed data of one or more 
Speed Traps over a user-specified time. 

 

Figure 3-24: Speed Trap Report 

3.8 SYSTEM LINKS 
 

 
The creation of a system link captures all the necessary configuration data for a link that connects one 
inbound or outbound intersection with another. 
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3.8.1 Create a System Link 

 

Figure 3-25: Create a System Link 

1. Select: Devices & Displays > Arterial > Create System Link. 

 

Figure 3-26: Create a System Link 2 

2. Complete the System Link Properties (see table below). 

3. Click Finish once all required fields have been completed. 
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3.8.2 Controllers 
Table 3-18: Create a System Link - Controllers 

Origin Controller The first traffic Controller assigned to a new link. It may connect to the 
destination Controller of another link. 

Destination Controller 
The second traffic Controller assigned to a new link. It may connect to the 
origin Controller of another link. 

3.8.3 General 
Table 3-19: Create a System Link - General 

Name User can accept the default name provided which is created by 
Transparity by appending the origin Controller name to the destination 
Controller name. 

System Id This is the unique number assigned to each Traffic Controller added to 
Trans parity. 

Tru-Traffic Id Unique Id assigned by the TruTraffic Offset software. 

Movement 
The movement of the Origin and Destination portions of a Link. Can be 
Through, Left, or Right. 

Direction 
The East, West, North, etc. direction of and arterial and the links that 
comprise it. 

Length 
The number of feet in a link, or the distance in feet between the end of the 
origin intersection and the beginning of the destination intersection. 

Speed The value allowed on a link. (I.e. 35 MPH). 

Lanes 
This is the unique number assigned to each Traffic Controller added to 
Transparity. 

Capacity The total platoon capacity that the link can support. 

3.8.4 Congestion 
Table 3-20: Create a System Link – Congestion 

Speed Threshold • Low-Medium (MPH) 

• Medium-Heavy (MPH) 

Occupancy Threshold • Low-Medium (%) 

• Medium-Heavy (%) 

Volume Threshold • Low-Medium (VPH) 

• Medium-Heavy (VPH) 
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3.8.5 Detectors 
Table 3-21: Create a System Link – Detectors 

 

Available Detectors 

A conclusive list of detectors managed by the CSS software. Selecting 
the “+” symbol results in the associated detector being added to the link 
being            created. 

Selected Detectors 
Detectors that have been assigned to the link being created by moving 
them from the Available Detectors screen to the Selected Detectors 
screen. 

3.8.6 System Link Summary 
1. To view the System Link Summary: Home > Arterial > System Link Summary. 

2. Right-click on a summary item, or selecting one of the summary 
buttons enables the following capabilities: 

• Create a new System Link. 

• Edit (Selected) System Link. 

• Delete (Selected) System Link. 

• Print the summary listing. 

3. Use the Filter capability to search and isolate a particular profile 
(See expansion arrow in graphic below). 

4. Select the Print button to print the summary listing. 
 

Figure 3-27: System Link Summary 
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3.9 GROUPS 
3.9.1 Create a Control Group 

Creating a traffic Control Group allows users to create groups of traffic Controllers subject to a 
common set of controls versus being controlled individually. This is an important capability when 
it comes to trying to coordinate several intersections on an arterial, as an example. 
 

1. To create a control group: Devices & Displays > Groups > Create Control 
Group. 

 

 

Figure 3-28: Create Control Group 

1. Complete the Group Properties (Fields with a red dot require completion). 

2. Create a Control Group - General: 
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Table 3-22: Create a Control Group – General 

Name Select the Traffic Controller Device type (i.e. McCain Omni eX). 

 
Type 

Four types of Control Groups can be created: 

• Coordination 

• Adaptive 

• Jurisdiction 

• Ramp Meter 

Description • A short description of the control group being created can be entered 

 

3. Create a Control Group – Controllers: 

Table 3-23: Create a Control Group – Controllers 

 

Control Group 

Select the Traffic Controller that will be included in the control group by 
selecting the “+” symbol which moves them from the Available Controllers 
group to 

the Selected Controllers group. 

Manual Override 
Placing a check mark in the box next to Manual Override allows the user to 

manually override the current pattern running in a control group. 

 

4. Manual Override – Check this box to ensure the control group is 
subject to manual override commands. 

Figure 3-29: Check for Manual Override 
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5. Click Add Controllers to place additional Controllers in the group. 

 

Figure 3-30: Add Controller Group 

6. Click Finish to create the new Controller group. 

3.9.2 View Group Summary 
1. To view a list of all device groups, select: Devices & Displays > Groups > Group 

Summary. 
 

Figure 3-31: View Group Summary 

2. All traffic Controller control groups are listed in order by name. 
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Figure 3-32: View All Control Groups 

a. The default view also showcases the name of the traffic Controller 
control group, a profile type (i.e. Responsive, Advanced Adaptive 
Pattern, Basic Adaptive Pattern), check box which indicates whether 
the group may be overridden and any available description. 

b. Right Click on a summary item. 

 OR 
a. Select one of the summary buttons to enable the following capabilities: 

• Create a Group. 

• Edit Group. 

• Delete Group. 

• Pattern Control (the current pattern running on a group). 

3. Use the Filter to search and isolate a particular profile (See 
expansion arrow in graphic below). 

4. Select the Print  button to print the summary listing 

3.10 ARTERIAL ROUTE BUILDER 
The creation of an Arterial Route captures all necessary configuration data for a route along an 
arterial that connects one intersection with another. 
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Figure 3-33: Build an Arterial Route 

3.10.1 Create an Arterial Route 
1. Select: Devices & Displays > Arterial > Arterial Route Builder. 

 

 
Figure 3-34: Create an Arterial Route 
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2. Right click on the Arterial Route pane to initiate a context menu to 
create, delete, save, or discard arterial routes. (See "Arterial Route 
Map Display Mini Map " on page 81. 

Figure 3-35: Map Web Display 

3. Use this pane to create a new Arterial Route  by 
selecting an existing group of traffic Controllers in the Web Map 
Display pane along the route you want to designate as an arterial 
route. This process will also result in populating the associated 
fields of the following Arterial Route Builder panes and tabs: 

• Arterial Route Nodes pane. 

• Forward System Links pane. 

• Forward Arterial Route Movements pane. 

• Arterial Route Properties tab. 

• Route Item Properties tab. 
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 Arterial Route Builder Toolbar  
The Arterial Route Builder Toolbar is in the top right-hand portion of the screen. 
 

 

Figure 3-36: Arterial Route Builder Toolbar 

Create Route • Create Route is used to create a new route in the Arterial 
Route expansion list 

Save Selected Route 
•  Used to save a new route that has been created during the current 

sitting 

 

Save all Modified 
Routes 

•  If the user has created multiple arterial routes in the current 
sitting, he/she can then use the ‘Save all modified routes’ icon 

Discard Selected Route 

Changes 

 

• This will result in selected route changes being discarded 

Discard All Route • This will result in all route changes being discarded 

3.10.2 Arterial Route Builder Properties 
Table 3-24: Arterial Route Builder Properties 

 

 

 

• Generated when the user selects  from the Arterial Route 
Builder toolbar. The default name ‘Arterial Route’ is assigned to the 
newly created arterial route. The user can rename this route by selecting 
the Details 
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Arterial Route ‘Arterial Route Properties’ tab and modifying the default name 

‘Arterial Route’ located in the ‘Route Name’ field  

• An Arterial Route that has been previously saved can be deleted by 
selecting the ‘Delete Arterial Route’ icon. 

 

 

 

Arterial Route Nodes 

• Each Node (Traffic Controller) in the selected Arterial Route appears in 
this expansion list. 

• Selecting an Arterial Route Node (Traffic Controller) in this expansion list 

causes the related Node on the Arterial Route Builder Map Display to turn 

from blue to orange  indicating where the node appears in the 
arterial route being viewed. 

 

 
Forward System Links 

• This is the link that is forward of the origin node (Traffic Controller) 

• Selecting a Forward System Link in this expansion list causes the 
related Link on the Arterial Route Builder Map Display to turn from blue 

to orange  indicating where the link selected appears in the 
arterial route being viewed. 

 

 

Forward Arterial Route 
Movements 

Nodes in this list are used to enter a ‘Phase’ number to indicate the forward 
movement of the Arterial Route into the ‘Movement Phase’ field 

 under ‘Route Item Properties’ Tab  in the 
‘Details’ pane at the bottom of the Arterial Route Builder screen • 
Selecting a Node (Traffic Con- troller) in this expansion list places a note 
on the Arterial Route Builder Map Display indicating the placement of a 
node (Traffic Controller), its type, and Phase Number. 

 

3.10.3 Arterial Route Properties Tab 
Table 3-25: Arterial Route Properties Tab 

Route Name The name assigned to the new Arterial Route. 

Forward Flow Name The name assigned to the primary flow direction. 

Reverse Flow Name The name assigned to the secondary flow direction. 

Description 
Text to augment the information provided by other Arterial Route 
Properties fields. 

Two-Way If a two-way arterial route a ‘check mark’ is placed into this box. 

Controller The names of the traffic Controllers that comprise the arterial route. 
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3.10.4 Route Item Properties Tab 
Table 3-26: Route Item Properties Tab 

 

Origin Link 

The link between the traffic Controller node name selected in the 
‘Forward Arterial Route Movements’ group and the traffic Controller it is 
linked to in its forward direction. 

Destination Link 
The link between the second to last traffic Controller (or destination 
Controller) and the last traffic Controller (or destination Controller). 

Movement Type • Phase 

• Overlap 

Movement Phase • 1 through 8 

3.10.5 Arterial Route Map Display Mini Map 
Table 3-27: Arterial Route Display – Mini Map 

 

 

 

Mini Map 

• Can set the viewable portion of the map by moving the rectangle in 
the middle of the map. Located in the upper right-hand corner of the 
Arterial Route Map Display. 

• Launched by left clicking on the expansion arrow located in the upper right 

corner of the Arterial Route Map Display  

3.10.6 Arterial Route Map Display Context Menu 
Table 3-28: Arterial Route Map Display Context Menu 

Create • Traffic Controller 

• System Link 

 

 

 

Layers 

• Controls what is displayed on the Arterial Route Map Display. If 
selected and item will be displayed. Items selected are displayed by 
check marks next to the layer name like Examples are: 

• Intersections 

• Ramp Controllers 

• Field Masters 

• Browsable Devices 

• System Links 
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Relocate device to 
this location 

• This allows the user to left click on a location on the map and select a 
traffic Controller from the device list and have its LAT/LONG coordinates 
modified to reflect the point select. 

Show Large Icons 
• Selecting and unselecting this value allows the user to show default-

sized icons, or larger-sized icons. 

 Arterial Routes Summary 

1. To view the Arterial Routes Summary: Home > Arterial > Arterial Routes 
Summary. 

2. Right-click on a summary item, or selecting one of the summary 
buttons enables the following capabilities: 

• Create a new Arterial Route. 

• Edit (Selected) Arterial Route. 

• Delete (Selected) Arterial Route. 

• Launch Time-Space Diagram. 

• Print the Summary listing. 

3. Use the Filter to search and isolate a particular profile (See 
expansion arrow in graphic below). 

4. Select the Print button to print the summary listing. 
 

 

 Figure 3-37: Arterial Routes Summary 
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4.  REAL-TIME STATUS DISPLAY 
This section provides an overview of real-time and graphical displays of the Transparity 
TMS user interface: 

• "Map Web Display" below 

• "Create a Map GIS Display" on page 89 

• "Suitcase Display" on page 95 

• "Aerial Display" on page 96  

• "Cabinet Display" on page 103 

4.1 MAP WEB DISPLAY 
The Transparity Map Web Display allows users to easily view system devices and execute actions 
related to traffic Controllers, system links, field masters, browsable devices, and ramp Controllers. 

 

Figure 4-1: Viewing the Map Web Display 

4.1.1 Quick Access for Map Web Display 
Users may quickly access a variety of other control settings directly from the Map Web Display, 
including the following. 
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Table 4-1; Quick Access for Map Web Display 

Access the Controller sub-context menu Right-click on a traffic Controller. 

Create a new traffic Controller 
Right-click on the desired location on the map. 

Create Traffic Controller Will automatically populate the longitude and 
latitude under traffic Controller properties. 

Relocate a traffic Controller Right-click on the new desired location on the map 
and select Relocate Controller to this Location. 

Access the Map Web Display Context Menu 
Right-click on the map a Map Web Display Context 
Menu will appear: 

Select Layers 

Select the following layers in the Map Web Display 
Context Menu to display a corresponding icon, or 
icons on the Map Web until they are unselected.  

• Intersections 

• Ramp Controllers 

• Field Masters 

• Browsable Devices 

• System Links Create 

Select “Create” and one of the context items 
listed below to generate the add screen for the 
context item: 

• Traffic Controller 

• Ramp Controller 

• Field Master 

• Browsable Device 

• System Link 

Select to make Show Large Icons display larger than 
normal. 

4.1.2 Configure Map Web Display 
This overview describes how to generate and use the Map Web Display in the 
Transparity TMS software interface. 
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Figure 4-2: Map Web Display 

 Map Usage 

1. Select: Device Displays > Map Display > Map Web Display. 

a. The Map Web Display tab will appear in the primary workspace pane. 

b. The Map Web Display provides the user with a graphical 
user interface to perform the following actions: 

2. Create and Edit: 

• Traffic Controllers. 

• Ramp Controllers. 

• Field Masters. 

• Browsable Devices. 

• System Links. 

2. View Selected Map Layers (individually or ALL): 

• Intersections layer. 

• Ramp Controllers layer. 
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• Field Masters layer. 

• Browsable Devices layer. 

• System Links layer. 

3. Relocate Devices: 

• Traffic Controllers. 

• Ramp Controllers. 

• Field Masters. 

• Browsable Devices. 

4. Toggle between default and large icons. 

5. Access a device’s sub-context menu by right clicking on a device’s icon. 

6. Move the viewable area left, right, up, or down. 

7. Select between one of the following pre-set views: 

• Topographic View (default). 

• Terrain Base View. 

• Road View. 

• Shaded Relief View. 

• Physical View. 

• Aerial View. 

8. Zoom in or out on the map, or use one of the following pre-set zoom levels: 

• Region. 

• City. 

• Neighborhood. 

9. Observe the LAT/LONG of the current position of the cursor. 

10. Move the portion of the map currently being displayed by pulling it with 
the cursor, or by moving the rectangle in the high-level map displayed 
in the upper right-hand corner of the map currently being displayed. 

11. View a key that displays the current zoom level of the map web display viewed in 

kilometers (km) or meters (m). 

12. The Map Web Display in Product Information must be set by the user: 

• LAT / LONG. 
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• Default Zoom Level. 

• Default Coordinate System. 

• Shape File. 

4.1.3 System Configuration for Maps 
Set the default values that will be used each time the Map Web Display window is opened. 
 

1. To set these default values: Settings Icon > Options > Maps. 

 

Figure 4-3: Map Configuration 

2. Map Configuration. 

3. Enter and Save the values that will remain consistent each time the 
Web Map Display screen is opened: 

• Latitude. 

• Longitude. 

• Default Zoom Level. 

4. Shape File. 
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Figure 4-4: Configure Map Display 

5. Click Finish. 

4.1.4 Map Operational Status 
When using the Map Web Display, different colored dots display based on the current mode of the 
traffic Controller. Expand the black triangle in the corner of the map to show the status definitions. 

 

 

Figure 4-5: Map Legend 

Red Offline – Active (not responding to polls) 

Gray Inactive (not polled) 

Blue Free mode 

Green Coordinated mode 
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• Pulsing Green Transition mode (Transition is the state when a Controller is moving from one 
coordinated pattern to another, or from free operations into coordination) 

Yellow Controllers in Flash - Software Flash (operational mode), Cabinet Flash 
(alarm) 

Fuchsia Controllers with active PREEMPT or POLICE CONTROL alarms are fuchsia 

Turquoise Controllers in Adaptive / CIC enabled are turquoise 

4.1.5 Map Alarm Status 
On the Map Web Display, pulsing colored rings display based on the current alarm of the traffic 
Controller. The meaning of each ring color is as follows: 

 

Table 4-2: Map Alarm Status 

Red 0 
Major Alarms - cabinet flash, stop-time, police control Manual Control 
Enable, cycle fail, coordination fail 

Yellow 0 
External Alarms – Any external alarm bit active, any special function output 
active 

Blue 0 
Minor Alarms – Detector fail, keyboard entry, cycle fault, coordination fault, 
transaction in progress 

Silver 0 All other alarms – Local Override / Manual Override 

No Alarm No outer indicator is visible 

4.2 MAP GIS DISPLAY 
4.2.1 Create a Map GIS Display 

1. Select: Displays & Devices > Map Display > Create GIS Display. 

 

Figure 4-6: Map GIS Display 
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2. Complete the GIS Display Properties (see table below). 

3. Click Save. 

  

Figure 4-7: Create GIS Map Display 

4.2.2 GIS Display Properties 
Table 4-3: Map GIS Display Properties  

Name Name the Map GIS display. 

Description A short description to augment the name of the GIS Map Display name. 

 

Background Type 

Select the desired background type: 

• Local Geocoded 

• None 

 • Online ArcGis Tiles (Aerial) 

• Online ArcGis Ties (Physical) 

• Online ArcGis Tiles (Shaded Relief) 

• Online ArcGis Tiles (Street) 

• Online (ArcGis) (Terrain) 
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• Online ArcGis Tiles (Topographic) 

• Online Bing Tiles (Aerial) 

• Online Bing Tiles (Birdseye) 

• Online Bing Tiles (Road) 

• Online OpenStreetMap Tiles 

Background Color Select the desired background color. 

Background Resource 
Path Specifies the location of the background file. 

 

 

 

 

Feature 

One of the following feature types can be selected: 

• Traffic Controllers, 

• Ramp Controllers, 

• Field Masters, 

• Browsable Devices, 

• System Links, 

• System Detectors, 

• Streets, 

• Other 

Feature One of the above feature types (i.e. Traffic Controllers, Ramp Controllers. 

Feature Id Field 
A unique ID assigned to a GIS Feature and is mapped to the feature’s 
System Id in the CSS. 

 

 

File Type 

• Image Layer – A layer potentially created by an Authority’s GIS 
Map Department. 

• Vector Layer – Contains an array of points and lines that describe the 
features of that layer. The points can be Traffic Controllers, System 
Links, etc. 

Layer Resource Path 
File containing the data like the Feature Id Field used to map to the 
System Id fields of the Feature. 

 

4.2.3 Set Default System Map 
Once maps have been created, users can select one or more to view in the main work- space. 
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Figure 4-8: Default System Map 

1. To select the maps: Device & Displays > Map Display > GIS Display Summary. 

2. Single click the desired map then click “Map Display” to launch the map. 

3. Repeat to display multiple maps. 

4. Select the desired map and then click the Edit Display or Delete 
Display button, right click a desired map, and launch a context 
menu to Edit (Selection) or Delete (Selection) the map, or double 
click on the desired map. 

5. Use the Create button, or right click any map in the Map GIS Display Summary 
screen to create a new GIS map display. 

 

Figure 4-9: Map GIS Display Summary 

6. Use the Filter to search and isolate a particular profile (See 
expansion arrow in graphic below). 

4.2.4 Edit or Delete a Map GIS 
1. To edit or delete a map: Devices & Displays > Map Display > GIS Display 

Summary. 

2. Select the desired map. 

3. Select Edit Display. 

OR 

3. Select Delete Display button to make necessary changes. 
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4.3 SUBSYSTEM DISPLAYS 
Subsystem Displays provide users with the ability to view the status of select inter- sections on a 
custom background image. Each Summary (list) view in Transparity has a Print button. There, you 
can render data with custom columns, orders, and widths to format documents for printing or export. 
 
There are three types of Subsystem Displays: Coordinated, Subsystem, and Field Mas ter. 

 

Figure 4-10: Subsystem Displays 

• Coordinated: Displays type “coordinated” enable users to view the extended status 
of all intersections in a single view. In addition to alarm and operational status, this 
display may include cycle timers, detector actuations, and date/time of the 
Controller software. 

• Subsystem: Displays of type “subsystem” are designed to provide users with 
discretely defined static maps of intersection alarms and operational status. 

• Field Master: Displays of type “field master” were specifically developed to support 
legacy traffic Controller infrastructure (namely, the 170-traffic Controller with 
210/245 software). 
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4.3.1 Create Subsystem Display 
1. Select: Main Menu > Map Display > Create Subsystem Display. 

  Figure 4-11: Subsystem Display Menu 

2. Select the desired display type: Coordinated, Subsystem, or Field Master. 

3. Provide a common Name for the display. 

 

 

4. Select Add Device and choose the device of interest (i.e. a Traffic Controller). 

5. Move the status dot of the Device to the appropriate location on 
the background image. 

6. Add Items - In order to add status items to the Subsystem Display: 

a. Left click on the device status dot, then select Add Item. 

b. Choose the status item to display, then place the object on the background 
image as desired. 

 

b. Set the Item properties via the Item Properties window in the lower right of 

the Display. 

 

c. Use the Save icon in order to save results and switch to viewing mode. 
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4.4 SUITCASE DISPLAY 
The Suitcase Display emulates the functions and outputs of a suitcase tester. This display does not 
require configuration by the user and automatically plots the correct number of configured phases 
and/or system detectors. 

 

1. To access Suitcase Display: Traffic Controller Sub-Context Menu > Displays. 
Suitcase Display. 

 
 

Figure 4-12: Access Suitcase Display 

4.4.1 Understanding the Suitcase Display Showcases 
The Suitcase Display shows real-time status of phases, pedestrians, overlaps, preemption, and 
detectors on a single display. The operational mode, pattern, alarms,   
cycle timers, current date/time, and number of active alarms are also shown. 
 
Detector status includes the on/off state of the individual detector, fault state (stuck on/off/ erratic), 
volume and occupancy, and a command button for the cabinet detector reset function is also 
accessible. 
 
Command buttons for phases, pedestrian movements, and preemption allow users to place calls on 
each of these objects. 
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Figure 4-13: Suitcase Display 

4.5 AERIAL DISPLAY 
The Aerial Display provides the same functionality as the Suitcase Display with the added benefit 
of using a background image and device objects to represent the inter- section in its actual 
configuration. By default, the Aerial Display opens as an 8-phase intersection with a generic 
background image. 

 

1. To access: Traffic Controllers Sub-Context Menu > Displays > Aerial Display. 
 



Transparity® TMS Manual 

Version 1.7.3 

Page 97 of 228 

 

 

 

 

 

Figure 4-14: Access Aerial Display 

4.5.1 Create Aerial Display 

 Aerial Display 
1. Select: Device Explorer > Traffic Controllers. 

2. Expand the Traffic Controllers device list in the Traffic Devices menu. 

3. Locate the desired Controller. 

4. Right-click the Controller. 

OR 

1. Click the expand arrow to the right of Controller name. 

2. Select Displays. 

3. Select Aerial Display. 

4. Click the Edit         button on the upper right-side of the aerial 
display to configure (Drag and drop functionality allows for an item 
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to be selected and binds the item properties pane to the selected 
item’s properties for viewing and editing). 

5. Click on each of the expand buttons to ensure all entries are 
complete. 

6. Select Close when done using the Aerial Display. 
 

Figure 4-15: Configure Aerial Display Commands 

 Commands 
Table 4-4: Aerial Display – Commands Table 

Commands Expand Commands  to view Aerial Display commands 

Vehicle Places, or terminates Vehicle Calls  

Pedestrian Places, or terminates Pedestrian Calls  

Preempt Places, or terminates Preempt Calls  
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Figure 4-16: Aerial Display Commands 

 Edit 
Table 4-5: Aerial Display Map - Edit Table 

 

Edit 
Selecting         the icon launches the Edit Pane that allows the user to 
Modify parameters that control the Aerial Display Map interface. 

 

 

 

 

 

 

 

+ Add Item 

Selecting the right mouse button while hovering over the Aerial 
Display Map launches a Sub-Context menu that allows the user to Add a 
new Item to one of the Item Types (i.e. Generic, Pedestrian Phase, etc.). If 
the Item Type does not already exist for a new Item, it will be added when 
the new Item is added. 

Selecting  can also be used to launch the Sub-Context menu 
containing potential Item Types and their associated Items. All newly 
added Items will be into a new item repository located in the upper left-hand 
side of the Aerial Display Map. 

The user must drag and drop each new item from the repository  in 
the upper left corner of the Aerial Display Map. New Items will continue to 
populate the Item repository and must be dragged and dropped to their 
desired permanent location on the Aerial Display Map.  
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Delete Item 
Selecting an Item in the Type List that the user wishes to delete and then  

selecting the delete ico icon results in the Item being deleted. Selecting an 
Item on the Aerial Display Map and right-clicking on the mouse launches a 
menu that allows the user to delete the item. 

 

Background 
The icon displays the file name path for the version of the Aerial Display 
Map the user is currently viewing/modifying. 

 
Save 

Selecting the  icon saves all changes to the Aerial Display Map since 

the last save to the location indicated by the icon. 

 

Cancel 
Selecting allows the user to throw away all changes made to the 

Aerial Display since the last save  action. 

Close Selecting  closes the Editor. 

 

+ Items 
Selecting  launches a menu that contains a list of existing item 

Types for the Aerial Display that have been added using the  
icon. 

 

 

 

 

 

 

 

+ Item Properties 

Selecting  expands an interface that allows the user to: Add New 
Items: When adding a new Item to the Aerial Display graphic pane, the 

properties for the new Item are created using the  
interface. When the updates to the Item Properties fields are complete, the 

new Item can be saved using the save  icon. 

Modify Existing Items: Selecting, for example, the Item Type results in the 
display of one or more existing Generic Items being displayed. Selecting 
one of these Items results in that items’ properties being displayed in the 

 interface. This interface is then used to modify the properties of the 
Generic Item selected. Items, like the Generic Item that have had their 

properties modified can then be saved using the save  icon. 

+ Generic All Items (i.e. Cabinet, Camera) that have been added to the Aerial 
Display Graphics Pane. 

 

4.5.2 Customize the Aerial Display 
Transparity TMS makes it easy for users to Customize the Aerial Display including: 

• Upload a custom background image. 

• Add items to the map. 
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• View a list of all active map items. 

• Modify properties of active map items. 

 

Figure 4-17: Suitcase Display 

6. Click the Edit button  in the upper right corner. 

7. The menu that allows the user to Add Items will open. 

8. Click  OR . 
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OR 
 

Figure 4-18: Customize Aerial Display 

 Customize the Background of Aerial Display 
Display parameters are visible on the Aerial Display when you click the pencil icon in the upper right 
corner. When you select an object on the palette, you get the edit bar on the right, and you can see 
opacity, label color, and font color there. Aspect ratio is also visible in the upper right when in Edit 
mode. 

 

1. Select: Edit > Generic. Cabinet > Item Properties. 
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Acceptable image types for the background are PNG, JPG, GIF, or TIFF. Use dropdown menus for 
Label Color and Label Font Color. 

Figure 4-19: Customize Aerial Display 

2. Click on any subject in Edit mode to open the Properties at the bottom of the 
page. 

FIGURE 4-18: Edit Properties in Aerial Display 

4.6 CABINET DISPLAY 
The Cabinet I/O Display allows the user to monitor input actuations and load switch outputs as they 
appear in various traffic Controller cabinets. Graphic representations of the real-time status of the 
cabinet input and output files are displayed. 
 
Input channels are identified according to detector number. Input activity is displayed as a solid 
bright-green LED simulation. Outputs are identified according to switch pack (load switch) number 
and color. Intersection identifiers - intersection name, location, system reference number, and 
communications addresses - are also shown. 
 



Transparity® TMS Manual 

Version 1.7.3 

Page 104 of 228 

 

 

 

 

 

Figure 4-20: Cabinet Display
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5.  CHAPTER 5: TIMING 
The Transparity Timing Editor enables users to view, edit, copy, and compare timing parameters for 
any intersection configured in the central system. 
 
This section provides an overview of: 

 

• "Introduction to the Timing Editor" below 

• "Timing Editor Menu" on the next page 

• "Change Tracking and Parameter Validation" on page 113 

• "Timing Archives" on page 114 

• "Timing Audit" on page 119 

• "Import and Export Timing" on page 119 

• "Group Timing Editor" on page 120 

• "Synchro" on page 123 

5.1 INTRODUCTION TO THE TIMING EDITOR 
The Timing Editor displays the number of phases, overlaps, detectors, patterns, and schedules to 
reduce the complexity of timing management and printed timing sheets. 
 
The Timing Editor allows side-by-side comparison of data from different sources to allow users to 
perform a timing audit which produces a list of differences between the central system record of timing 
and the timing of the field device. 
 
Copy Data refers to functionality added to the Timing Editor to allow an end user to copy an object's 
parameters to another object (like Phase 1's parameters copied to Phase 2). It also allows entire sets 
of data to be copied to another set (such as a Set, or a Bank, as a table of data). Phase Set 1 contains 
parameters for phases 1-16, and Phase Set 2 contains a second copy of all those parameters to be 
configured differently. Copy Data allows Phase Set 1 to be copied to Phase Set 2 so that the user 
doesn't have to hand punch all these values individually. 
 
QuicComm® is McCain's legacy intersection control protocol. There are many different legacy 
programs that use this protocol. Transparity supports them, as they all have Timing Editor pages. If an 
intersection is upgraded from some legacy QuicComm program, Transparity will convert basic 
parameters from the QuicComm version to the corresponding Omni eX version. For example, phase 
minimum green time is between common programs, so those values are carried over. 
 
Limited timing migrations and QuicComm to Omni eX are part of the same module. They deal with 
converting configuration from one device type to the other or from one version of a device to a different 
one. 
   
The data on the timing pages saves to a timing database for each intersection. Transparity allows you 
to archive that timing database and call it up later to compare with what is currently configured for an 
intersection and copy values back to the current configuration or download the archived copy back to 
an intersection. Printing timing archives is a feature which allows you to print an archived timing 
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database directly instead of having to go through steps to override the current database just to print 
those archived values. 
 
Omni eX Timing Editor previously had a maximum of 16 Day Plans. That has now been updated to a 
maximum of 64 Day Plans to match between Transparity and Omni eX. 
 
Edited data can be saved to the central system database, saved to the field device data- base, 
exported, or archived for later use. 
 

1. To access: Device Explorer > Timing > Editor. 

5.1.1 Data Sources 
The Timing Editor can be loaded with data from various sources including: 

• Central system database. 

• Field device database. 

• Archives. 

• External file. 

5.2 TIMING EDITOR MENU 

 

Figure 5-1: Timing Editor Menu 
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5.2.1 File Menu 
1. Use the File tab to view Device Information. The user may 

also access the following processes from the File or 
backstage menu: 

• Archive – Store timing device timing. 

• Template - Create and use templates. 

• Export – Export Timing to use in other devices. 

• Save – to the system or a device. 

• Audit – From any stored device. 

• Print – Print all manner of saved timing. 

 

Figure 5-2: File Menu 

 



Transparity® TMS – User Manual 

Version 1.7.3 

Page 108 of 214 

 

 

5.2.2 Save Menu 
 

Figure 5-3: Save Menu 

The user may Save from the Save menu or the File menu, as shown in the previous step. 

5.2.3 Edit Menu 

Figure 5-4: Edit Menu 

The user may Undo All Edits or Restore Defaults from the Edit menu. 

5.2.4 View Menu 
 

 Figure 5-5: View Menu 

The user may Compare Data and refresh comparison data from this menu. 
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5.3 PAGE EXPLORER MENU 
 

 Figure 5-6: Page Explorer Menu 

Each of the sub-context menus under the Page Explorer may be expanded to expose the tools 
needed to program various timing elements. 

5.4 USE THE TIMING EDITOR 
5.4.1 Phase Timing 

1. Select: Device Explorer > Traffic Controllers > Traffic Controller Sub-Context 
Menu > Timing Editor > Page Explorer > Phases > Phase Timing. 

Figure 5-7: Phase Timing Menu  

2. The user may edit timing on this page. 
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Figure 5-8: Edit Phase Timing 

Users can easily overwrite working data fields with updated timing within the Timing Editor. 
Modifications are not committed to the central database or field device until a Save action is 
selected. 

3. There are four options for saving data: 

• Save All to System. 

• Save Page to System. 

• Save All to Device. 

• Save Page to Device. 

 

Figure 5-9: Save Edits 

4. Saving the parameters to the Transparity central database helps 
preserve the synergy between central and field device timing 
parameters. If it is necessary to update the field device with 
temporary timing, the user should first preserve the permanent copy 
of timing in the form of an archive. 

5. Controllers configured for more than eight phases: 

a. The menu bar will show the current set and phase in view. 
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Figure 5-10: Additional Sets and Phases 

b. Click on the Set or Phase to change the current view to the desired view. 

Figure 5-11: Change Set / Phase View 

5.4.2 Working Data vs. Comparison Data 
The Transparity Timing Editor allows users to change the data source for both working and 
comparison data. This allows users to easily compare timing parameters from multiple origins such as 
timing archives, field data from another Controller, central database timing for another Controller, or 
external files exported directly from the field device. 
 
Working Data– Editable data that can be saved to the central database, field device database, 
archived, or exported. By default, working data is the database record of device timing. 

 

Comparison Data – Read-only data from other data sources (referenced above). 
 

1. Click View to compare data. 

Figure 5-12: Compare Timing 

2. Choose the Source from the dropdown menu. 

3. Select the Traffic Controller to compare with from the file menu. 
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Figure 5-13: Compare Timing 

4. The comparison screen will load and show the Original source in 
white and the eight phases of the Comparison source in yellow. 
Any Discrepancies will appear in pink. 

 

Figure 5-14: Timing Comparison 

5. From this screen the user may edit, print, save or adjust any timing issues. 

5.4.3 Hide Working Copy 
To remove the view of the working comparison and show only the original source complete the 
following: 
 

1. Click View. 

2. Click Hide Working. 
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Figure 5-15: Hide Working Copy 

5.4.4 Change Tracking and Parameter Validation 
When editing timing parameters, the Timing Editor tracks all unsaved changes and per- forms 
validation checks against each edited field. Users cannot save changes until all validation errors 
have been resolved. 

 

 

Figure 5-16: Timing Editor - Unsaved Changes and Validation Tracking 

Figure 5-17: Working Data vs. Comparison Data 
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5.4.5 Phase Options 
1. Select: Page Explorer > Phases > Phase Options. 

2. Click Phase Options. 

The graphics below show both the settings of the original and the comparison 
Phase Options. 

3. Click in the desired box to activate any phase options. 

 

Figure 5-18: Phase Options 

4. From this screen the user may edit, print, save or adjust any Phase Options. 

5.5 TIMING ARCHIVES 
The Transparity Timing Archive features allows users to easily create, restore, and manage archived 
timing. 
 
All Timing Archive features are accessed through the Timing Editor. 

5.5.1 Create/Edit a Timing Archive 
1. To archive timing in the central database: Devices & Displays > Timing > 

Archives. 
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Figure 5-19: Access Timing Archives 

2. Double-Click the desired archived Controller to view and/or delete. 
 

Figure 5-20: Timing Archives 

3. Click on Create, to build a new archive. 

Figure 5-21: Create Archive 

4. Select the desired Controller. 
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Figure 5-22: Select Controller for Archive 
5. Click OK. 

6. Complete the Timing Archive Properties. 

 

Figure 5-23: Timing Archive Properties 

7. Click Save. 

5.5.2 Restore Archived Timing 
1. To restore a timing archive: Devices & Displays > Timing > Archives. 

2. Locate the desired Controller. 

3. Right-click to open the Controller Sub-Context Menu. 

4. Select Timing Editor. 

5. Click View > Compare Data. 

6. Select Archive under Compare Source. 

7. Select the desired archive timing from the window that will 
appear with a list of available timing archives. 

8. Click OK to compare the current working data to the archived data. 

9. Click the Copy Comparison to Working button to apply the 
archive timing parameters to the working data. 
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10. Click Save Timing to Database or Save Timing to Database and 
Send to Device to apply the changes. 

 

Figure 5-24: Restoring a Timing Archive 

5.5.3 Download Timing 
1. To download timing, locate the desired Controller under Traffic Devices > 

Traffic Controllers. 

2. Right-click to open the Controller Sub-Context Menu. 

3. Select Timing Editor. 

4. Click in the Timing Editor window: 

a. Save All Timing to Database to save the archived timing to 
the central database. 

OR 

a. Save All Timing Data to Database and Update Device to 
also update the field device. 

5. Select the desired archive timing from the window that will appear with a list of 
available timing archives. 
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5.6 TIMING TEMPLATES 
Timing Templates permit users to create pre-configured templates for common intersection 
phasing. Previously created templates can be applied to newly created intersections in order to 
populate a standard set of timing parameters or templates can be applied after creation of an 
intersection. 

5.6.1 Creating a Timing Template 
There are two options for creating a timing template: 

1. Assign a user-friendly Name and Description for ease of use when 
implementing a template from the Main Menu > Timing > 
Templates >. Then select the traffic Controller from which you’d like 
to create the template. 

OR 
1. From the Timing Editor Menu of a Controller > File > Templates. 

2. Once the Timing Template dialog has opened: 

Figure 5-25: Create a Timing Template 

3. Click Save. 

5.6.2 Implementing a Timing Template 
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5.7 TIMING AUDIT 
Quickly identify data mismatches between the central database and the traffic Controller timing 
parameter database with the Transparity Audit Timing feature. 
 

1. Conduct an audit by doing the following: Devices & Display > Timing > Audit 

 

Figure 5-26: Timing Audit 

2. Click the File icon to find and select the desired Controller. 

3. Click OK once the desired Controller is highlighted. 

a. The system will retrieve all timing parameters from the 
designated traffic Controller and compare the values to those 
of the central system database. 

b. A detailed list will be produced identifying the differences. 

4. Click on a mismatched item to open the Timing Editor in compare 
mode to update the traffic Controller or central dataset. 

5.8 IMPORT AND EXPORT TIMING 
When not directly connected to a traffic Controller, the exchange of timing parameters can be 
accomplished using the Transparity Import/Export feature. 
 
Users may import records of timing records from Controller exports saved as files on the file system. 
Users may also export timing to file to be later applied to the traffic Controller via USB. 
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5.9 GROUP TIMING EDITOR 
The Transparity Group Timing Editor allows users to view, upload, or download select timing 
parameters for Coordination or Adaptive Groups of traffic Controllers. This Editor allows the user to 
see related parameters for multiple Controllers side-by-side to make Time of Day coordination easier 
to review and implement. 
 
There are two ways to launch the Editor. 
 

1. Navigate to the following using the main menu: Devices & Displays > Groups 
> Group Timing Editor. 

OR 
1. Open the context menu of a Coordination Group and select: Group Timing 

Editor. 

2. By navigating from the main menu, you are asked to select a 
group before the main view is loaded. 

 

Figure 5-27: Launch Group Timing Editor from a Coordination Group Context Menu 

Within the Group Timing Editor view you are presented with a navigation bar similar to the 
standard Timing Editor navigation bar. From here, you may select a group or pat- tern for which to 
modify timing. You are also given options to save timing changes to the system or to the devices. 

5.9.1 File Menu 
Within the main body of the backstage opened by this menu, basic information is displayed for the 
currently selected group as well as an Edit button to open the Edit Wizard for that group. The menu 
on the left allows saving timing to system or device. 
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Figure 5-28: File Menu on Group Timing Editor 

Figure 5-29: Group Timing Editor 

5.9.2 Splits and Force Offs 
Phase coordination pattern timing can be expressed in splits or force offs. The value displayed is a 
function of what value is native to the traffic control program. 
 
For NTCIP-based programs, splits are displayed. For QuicComm-based programs, force offs are 
displayed. The type of value is displayed as background text right-justified within the input field. 
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Figure 5-30: View Coordination Parameters in Group Timing Editor 

The Transparity Group Timing Editor also visualizes the cycle for the selected traffic con- troller via 
the Phase Split Diagram at the bottom of the view. You must first select a con- troller in order to view 
its cycle data. Select a Controller by clicking on its heading in the Title row or by clicking in any of 
the input fields under that Controller. 
Figure 5-31: Phase Split Diagram in Group Timing Editor 

Each ring in the cycle is shown in a stacked view with Ring 1 on top. Clearance times are visible, and 
phase green times are adorned with the phase number. The far-left bar marked 0s represents the 
local cycle zero point and the far-right dashed line indicates the length of the cycle. 

5.9.3 Save Timing 
The Save menu provides options to save all to system and device. In this context, unlike the 
standard Timing Editor, “all” refers to the visible coordination timing parameters and not all timing 
parameters supported by the traffic Controller. 
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Figure 5-32: Save Timing 

5.10 SYNCHRO 
Transparity provides integration with Synchro versions 9 and later. This means a user operating both 
systems can transfer timing data between them in order to study, optimize, and implement timing for a 
coordination plan for a group of intersections. 
 
The user story around this integration is for customers running a Synchro system in their traffic 
management center who wish to optimize timing for a corridor. In order to do so, they must have a 
Synchro diagram with timing to match the intersection timing in the field. Once timing is optimized, 
the user must implement the plans in Transparity TMS. 
 
This integration has been written to support this user story using the integration available off-the-shelf 
in Synchro 9 and above. From a high level, this looks like the following: 

 

1. Configure a coordination group in Transparity representing an arterial. 

2. Configure a diagram file in Synchro representing the same arterial. 
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3. Export the UTDF timing data in Synchro to CSV file. Refer to the 
Synchro manual for how to accomplish this. 

4. Export timing in Transparity to Synchro. 

5.10.1 Synchro Prerequisites 
There are some important steps that must be performed first, both in Synchro and Transparity. 
 

1. Create a Synchro diagram file representing the desired 
intersections to coordinate. This may be a diagram of just the 
intersections along a coordinated arterial, but the diagram may also 
be a network or city-wide diagram file. It is important that all 
intersections in the Transparity group to be optimized are found in 
the diagram file. 

 

 

2. Associate the Synchro-designated identifiers for each 
intersection with the corresponding Intersection in 
Transparity. 

a. Open the Edit Traffic Controller wizard. 

b. Navigate to the Advanced page. 

c. Enter the identifier from Synchro into the Synchro Id field. 

Figure 5-33: Entering the Synchro Id into the Traffic Controller  
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5.10.2 Export Timing from Synchro 
Synchro writes data to CSV file in the UTDF format. There are many parameters inside this format 
used and managed by Synchro that are not utilized by Transparity. In order to send timing to 
Synchro over UTDF, Transparity must take a Synchro-exported file and overwrite the relevant 
timing parameters with data from Transparity. That is why, even when exporting timing from 
Transparity, the user must start with a file exported from Synchro. 

5.10.3 Export Timing from Transparity 
Using the file exported in the previous step: 

 

1. Navigate to Timing > Synchro Data. 

2. Specify the group, pattern, and Synchro UTDF file desired to export data to. 

3. Click the Export button. 

 

  Figure 5-34: Group Timing Editor 

5.10.4 Import Timing into Transparity 
 

 Import Timing into Transparity 
1. Navigate to Timing > Synchro Data in Transparity using the file 

exported from Synchro containing the optimized timing data. 
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2. Specify the group, pattern, and Synchro UTDF file to export data to. 

1. Click the Import button. 

2. Timing will be imported into the Group Timing Editor where the 
specified and pattern are pre-selected. Nothing has been modified 
in the system at this time. The user can now view the optimized 
timing and make changes. From the Group Timing Editor, the user 
can save the timing to the system or devices. 

3. Click Update Diagram to manually update the diagram. 

a. If the Real-Time checkbox is checked, then this will occur 
automatically each time Pattern Update Interval is reached.
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6.  OPERATIONS AND MANAGEMENT 
This section allows for oversight of notifications, planned operations, tasks, and time 
synchronization. This section provides an overview of how to create and manage: 
 

• "Events" below 

• "Schedules" on page 134. 

• "Signal Pattern Control" on page 144. 

• "Group Pattern Control" on page 145. 

• "Time/Date Broadcast" on page 146. 

• "Remote Downloads" on page 149. 

• "Service Tasks" on page 152. 

6.1 EVENTS 
6.1.1 Create an Event Notification 

Events are occurrences within the system that can trigger a user email notification. 
 

1. Select: Management > Events > Create Event Notification. 

2. Complete the Event Notification Properties (see table at "Event 
Notification Properties on page 128). 

3. Click Save. 
 

   Figure 6-1: Create an Event Notification 
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6.2 EVENT NOTIFICATION PROPERTIES 
6.2.1 General 

Alarms may be set to monitor a select group of intersections or a particular intersection.  
One or many event alarms may be set. 

 

Table 6-1: Event Notification – General – Table 

Name Unique Name assigned to the Event Notification scheduled task 

 

Event Type 

• Traffic Event 

• Link Event 

• Ramp Event 

Enabled Without a check mark in this check box the Event Notification task will not 
run 

Description Allows the user to create a small description for the Event Notification task 

6.2.2 Events 

  Figure 6-2: Events - General 

Depending on the type of event (Traffic, Link, or Ramp), a different set of unique names is displayed. 
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Table 6-2: Event Notification - Events 

Name Unique name assigned to the event 

 

 

 

 

 
Traffic Event 

• Coordination Alarm 

• Coordination Fail 

• Coordination Fault 

• Critical Alarm 

• Cycle Fail 

• Cycle Fault 

• Detector Fault 

• External Alarm 

• Local Override 

• Manual Plan 

• Preempt 

• TF Flash 

 

Link Event 

• Congestion Occupancy Heavy 

• Congestion Speed Heavy 

• Congestion Volume Heavy 

 

Ramp Event 

• External Alarm 

• Offline 

• Ramp Alarm 

 

The event is then either Added, Removed, or Added/Removed. 
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Figure 6-3: Events - Add, Remove, or Add/Remove 

Table 6-3: Event Notification - Trigger 

Added Event is added 

Removed Event is removed 

Added/Removed Event is both added and removed 

6.2.3 Users 
The user and the event acknowledgement delay are selected next. There are three tiers of users and 
a checkbox to set if the event notification requires acknowledgement. The usernames are displayed 
according to tier. If an event alarm goes active and the user does not acknowledge the alarm within 
the selected time delay, the next tier of users is notified of the event. Tier 1 is notified of the event first. 
If there is a Delay Before Escalation set, the system waits that amount of time before moving to the 
name(s) in the next tier and notifying them. All users in the next Tier are notified after expiration of 
the acknowledgement period in the previous tier. This continues until Tier 3 is reached. 
 
User(s) may acknowledge the event alarm notification by using the Unacknowledged Events screen 
and selecting the appropriate event(s). See Section "Unacknowledged Events" on page 133. 
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Figure 6-4: Traffic Event - Users 

Table 6-4: Event Notification - Users 

Requires 
Acknowledgment Acknowledgment required from user(s) to avoid escalation. 

Add User 
Users in the Transparity TMS that have been selected to receive any or all 
Traffic, Link, and Event notifications. 

Delay Before 
Execution Number of Hours and Minutes to delay before notification. 
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6.2.4 Properties 
 

Figure 6-5: Event Notification - Properties 

Table 6-5: Event Notification Properties 

All Controllers Available Traffic Controllers: All Traffic Controllers in the Transparity TMS that 
are available to send Traffic Event Notifications 

Selected Groups 
Available Ramp Controller Groups: All Ramp Controller Groups in the 
Transparity TMS that are available to send Ramp Event Notifications 

Add Group Select to add a particular group from a drop-down list. 

6.2.5 Event Notification Summary 
1. To view a summary of all event notifications, Management > Events > Event 

Notification Summary. 

2. Right-click on a summary item, or selecting one of the summary 
buttons enables the following capabilities: 

• Create a new Event Notification. 

• Edit (selected) Traffic Event Notification. 

• Delete (selected) Traffic Event Notification. 

2. Use the Filter to search and isolate a particular Event Notification profile. 
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Figure 6-6: Event Notification Summary 

6.1.2 Unacknowledged Events 
This is the list of unacknowledged alarms which is where the user executes the "acknowledgement" 
and terminates the alarm notification escalation to the next tier. 
 

1. To view a list of all unacknowledged events, Management > Events > 
Unacknowledged Events. 

2. Select either: 

• Ack Event: to Acknowledge an event and terminate the 
alarm notification escalation. 

• Ack Selected Events: to Acknowledge selected events and terminate the 

alarm notification escalation. 

 

• Ack All Events: to Acknowledge all events and 
terminate the alarm notification escalation. 

 

Figure 6-7: Unacknowledged Events 
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6.3 SCHEDULES 
The Transparity Scheduler is a wizard-style tool that walks users through a series of setup steps to 
capture all necessary configuration data for each category of schedule. 

6.3.1 Types of Schedules 
A variety of different schedules can be created in the Transparity Scheduler, including: 

 

Table 6-6: Types of Schedules 

System 
Maintenance 

Delete Activity Logs 

Traffic Data Retrieve Controller Logs 

Traffic Maintenance Aggregate Detector  

         Data     Aggregate Detector Data 

 

Traffic Operations 

Broadcast Time         Check Time Drift Run 

Traffic Command     Set Pattern 

Run Timing Audit 

6.1.3 Use the Scheduler 
The Transparity Scheduler provides a single interface to provide users with a step-by- step process of 
creating a variety of new task schedules. 
 

1. To create a schedule, select: Home > Schedules > Create Schedule. 
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Figure 6-8: Create Schedule 

2. Use the wizard to add the necessary data to create a schedule. 

3. Click each of the expand buttons to ensure all entries are 
complete. All fields marked with a red dot are mandatory. 

4. Select the Category of the schedule you would like to create. 

5. Click Next. 

6. Follow the self-explanatory steps on the subsequent pages to 
create the desired schedule. Users may easily return and update 
any of these fields at a later date and time. 

7. Click Finish to create the schedule. 

6.3.2 Create a New Schedule 
The Transparity Scheduler creation wizard makes it easy to create a new schedule.  

1. To create a schedule: Management > Schedules > Create 
Schedule 

2. Use the wizard to walk through adding the necessary data to create a schedule. 

3. Select the Category of the desired schedule. 

4. Click Next. 
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2. Follow the self-explanatory steps on the subsequent pages to 
create the desired schedule. Users may easily return and update 
any of these fields later. 

3. Click Finish to create the schedule. 

6.2.3.1 Category 
Table 6-7: Creating a Schedule – Category 

System Maintenance • Delete Activity Logs 

Traffic Data • Retrieve Controller Logs 

 

Traffic Maintenance 

• Aggregate Detector Data 

• Delete Controller Logs 

• Delete Controller Status Logs 

• Delete Detector Logs 

 

 

Traffic Operations 

• Broadcast Time 

• Check Time Drift 

• Run Timing Audit 

• Run Traffic Command 

• Set Pattern 

6.2.3.2 General 
Table 6-8: Creating a Schedule - General 

Name • The name of the scheduled activity 

Schedule • Recurring DOM and DOW 

• Special Date 

 

Enabled 

• Place a check in the Enabled box if you want the scheduled 
task to execute. If unchecked, the scheduled task will not 
execute at the designated time and date 

Description • A short description of the scheduled event 
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 Schedule 
Table 6-9: Creating a Schedule – Option 

 
Recurring DOM 
and DOW (Option) 

• The user must enter: 

• Days of the Month 

• Months of the Year 

• Days of the Week 

• Start Time 

 

Special Date (Option) 

• The user must select: 

• One day of a month 

• Start Time 

 

 

Recurring Interval 
(Used for Category: 
Traffic Data - Only) 

• The user enters: 

• Occurs Every (i.e. Enter min, hour, etc.) 

• Starting Date (i.e. Enter Starting Date) 

• Has Ending Date (Check Mark in Check Box?) 

• No – No ending date 

• Yes – Enter Ending Date 

• Always Active (Check Mark in Check Box?) 

• No – Enter Start Time & End Time 

• Yes – No Start Time & End Time 

 

6.2.3.3 Action 
Table 6-10: Creating a Schedule – Active 

System Maintenance: 

Delete Activity Logs 
• Delete logs after <days> days. 

 

 

 
Traffic Data: 
Retrieve Controller 
Logs 

• The user can move whichever traffic Controller groups they wish to 
include in the Controller log retrieval process from the ‘Available Groups’ 
pane to the ‘Selected Groups’ pane. 

 The user can select the type of log to upload by placing a checkmark in the 
checkbox next to the following fields: 

• VOS 

• MOE 

• Speed 
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• Controller 

Traffic Maintenance: 
Aggregate Detector 
Data 

• Populate the following fields, or use the default data provided 

• ‘Use aggregation period of <minutes> minutes’ 

• ‘Aggregate data after <days> days’ 

 

 

 

Traffic Maintenance: 
Delete Controller 
Logs 

• Populate the following field, or use the default data provided 

• ‘Delete logs after <days> days 

 The user can select the type of log to delete by placing a checkmark in the 
checkbox next to the following fields: 

• VOS 

• Speed 

• MOE 

• Controller 

Traffic Maintenance: 
Delete Controller 
Status Logs Traffic 
Maintenance: Delete 
Detector Logs 

 

• Populate the following field, or use the default data provided 

• ‘Delete logs after <days> days 

Traffic Operations: 
Broadcast Time - 
Traffic Operations: 
Check Time Drift 

• The user can move whichever traffic Controller groups they wish to 
include in the ‘Broadcast Time’ process from the ‘Available Groups’ pane 
to the ‘Selected Groups’ pane 

 

 

Traffic Operations: 
Run Timing Audit 

• The user can move whichever traffic Controller groups they wish to 
include in the ‘Broadcast Time’ process from the ‘Available Groups’ pane 
to the ‘Selected Groups’ pane. 

• The user can move whichever Users they wish to include in the ‘Run 
Timing 

Audit’ process from the ‘Available Users to Notify’ pane to the ‘Selected 
Users to Notify’ pane. 

 

- Traffic Operations: 
Run Traffic Command 

• The user can select a ‘Command Profile’ from a list of ‘Available Profiles’ 
(i.e. Advanced Adaptive, Basic Adaptive, etc.) 

• The user can select the ‘Priority’ that the command profile will have in the 
queue. Priority levels from ‘1 Highest to 10 Lowest’ can be selected from 
an expansion field. 
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Traffic Operations: 
Set Pattern 

• ‘Pattern’ – The user selects the pattern from the expansion list that 
they would like to run. 

• ‘Priority’ – The user selects the priority from the expansion list that 
reflects the priority level they want the scheduled pattern action to run 
at. Priority levels from ‘1 Highest to 10 Lowest’ can be selected from the 
expansion field. 

• The user can move whichever traffic Controller groups they wish to 
include in the ‘Broadcast Time’ process from the ‘Available Groups’ pane 
to the ‘Selected Groups’ pane. 

 

6.2.3.4 Schedule 
Users will select when the desired schedule should run, for instance, by DOM, DOW, or  
by Special Dates as defined by the user. 

 

There can be more than one Special Date created per schedule. 
 

Figure 6-9: Create Special Date  
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Table 6-11: Selecting Scheduler Dates 

 
Recurring DOM and 
DOW (Option) 

The user must enter: 

• Days of the Month 

• Months of the Year 

• Days of the Week 

• Start Time 

 

Special Date (Option) 

The user must select: 

• One day of a month 

• Start Time 

 

 

 

Recurring Interval (Used 
for Category: Traffic Data - 
Only) 

The user enters: 

• Occurs Every (i.e. Enter min, hour, etc.) 

• Starting Date (i.e. Enter Starting Date) 

• Has Ending Date (Check Mark in Check Box?) 

■ No – No ending date 

■ Yes – Enter Ending Date 

• Always Active (Check Mark in Check Box?) 

■ No – Enter Start Time & End Time 

■ Yes – No Start Time & End Time 
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 Action 

Figure 6-10: Creating a Schedule - Action 

Select the particular action that a schedule will perform for each category selected.  
 
For example, if the user selects the category of traffic maintenance, one of two actions (i.e. aggregate 
detector data or delete Controller logs) may be chosen. 
 
There can be only be one category and one action per schedule. 

 

Table 6-12: Selecting Scheduler Dates 

System Maintenance: 

Delete Activity Logs 
• Delete logs after <days> days. 

 

 

 
Traffic Data: 
Retrieve Controller 
Logs 

• The user can move whichever traffic Controller groups they wish to 
include in the Controller log retrieval process from the ‘Available Groups’ 
pane to the ‘Selected Groups’ pane. 

• The user can select the type of log to upload by placing a checkmark in the 

checkbox next to the following fields: 

• VOS 

• MOE 

• Speed 

• Controller 
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Traffic 
Maintenance: 
Aggregate Detector 

Data 

• Populate the following fields, or use the default data provided 

• ‘Use aggregation period of <minutes> minutes’ 

• ‘Aggregate data after <days> days’ 

Traffic Maintenance: 
Delete Controller 
Logs 

• Populate the following field, or use the default data provided 

• ‘Delete logs after <days> days 

• The user can select the type of log to delete by placing a checkmark in 
the checkbox next to the following fields: 

• VOS 

• Speed 

• MOE 

• Controller 

Traffic 
Maintenance: 
Delete Controller 
Status Logs Traffic 

Maintenance: 

 

• Populate the following field, or use the default data provided 

• ‘Delete logs after <days> days 

Traffic Operations: 
Broadcast Time 
Traffic Operations: 
Check 

Time Drift 

• The user can move whichever traffic Controller groups they wish to 
include in the ‘Broadcast Time’ process from the ‘Available Groups’ pane to 
the ‘Selected Groups’ pane. 

 

 

Traffic Operations: 
Run Timing Audit 

• The user can move whichever traffic Controller groups they wish to 
include in the ‘Broadcast Time’ process from the ‘Available Groups’ pane to 
the ‘Selected Groups’ pane. 

• The user can move whichever Users they wish to include in the ‘Run 
Timing 

Audit’ process from the ‘Available Users to Notify’ pane to the ‘Selected 
Users to Notify’ pane. 

 

Traffic Operations: 
Run Traffic Command 

• The user can select a ‘Command Profile’ from a list of ‘Available Profiles’ 
(i.e. Advanced Adaptive, Basic Adaptive, etc.). 

• The user can select the ‘Priority’ that the command profile will have in the 
queue. Priority levels from ‘1 Highest to 10 Lowest’ can be selected from 
an expansion field. 
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Traffic Operations: 
Set Pattern 

• ‘Pattern’ – The user selects the pattern from the expansion list that they 
would like to run. 

• ‘Priority’ – The user selects the priority from the expansion list that reflects 
the priority level they want the scheduled pattern action to run at. Priority 
levels from ‘1 Highest to 10 Lowest’ can be selected from the expansion 
field. 

• The user can move whichever traffic Controller groups they wish to include 
in the ‘Broadcast Time’ process from the ‘Available Groups’ pane to the 
‘Selected Groups’ pane. 

6.3.3 View Schedule Summary 
The Schedule Summary allows users to view and filter through existing schedules. It also provides 
an easy interface for creating, editing, deleting, or running schedules. 

 

 

Figure 6-11: Schedule Summary View 

 Schedule Summary 

1. To access the Schedule Summary: Management > Schedules > Schedule 
Summary. 

2. Select a Column Name to sort column alphabetically by whatever 
criteria is located under the column. 

3. The default view showcases the name of a schedule, the type of 
schedule, the action to be performed by the schedule, the 
schedule frequency, whether the schedule is enabled or not, and 
the description, if provided by the user. 
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4. Use the Filter to search and isolate any profile(s). 

6.4 SIGNAL PATTERN CONTROL 
The Signal Pattern Control window details the current operational status and all active sources of 
operational commands. In this manner, the user can better understand why a signal Controller is in 
the current operational mode. The Signal Pattern Control window reveals the hierarchy of 
command sources by listing the command sources in categorical priority. 
 
If two distinct command sources of equal category are set to issue conflicting operational 
patterns, the Signal Pattern Control issues the command issued by the source with the highest 
relative priority. The list of operational command sources includes: Current pattern and command 
source, manual pattern, regional patterns, special events, responsive patterns, Adaptive patterns, 
and time-of-day patterns. 

6.4.1 View Signal Pattern Control 
1. Select: Traffic Controller Sub-Context Menu > Operations > Signal Pattern 

Control. 

Figure 6-12: View Signal Pattern Control 

6.4.2 Manual Override 
Manual Override commands have the highest priority over all other sources of pattern control. Upon 
executing a manual override, all other command sources are ignored 
 until the manual override is removed. 

 

Table 6-13: Manual Override 

Send Selecting this button will result in the pattern selected in the override 
pattern dropdown being sent to the traffic Controller. 

 

Stop 

Selecting the stop button will remove the Manual Override Pattern. The 
traffic Controller will revert to the next pattern in the Signal Pattern Control 
hierarchy or if none, whatever the default local TOD schedule calls for. 

 

Override Pattern 

The pattern selected by the user to override the pattern currently running 
on a traffic Controller. After selection of the desired pattern, the Send 
button is selected to send it to the lane. 
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6.4.3 Description of Signal Pattern Control Sources 

 Manual Override 
As described above, a user initiated Manual Override overrides the established operational 
pattern of the selected intersection and continues this pattern until removed by the user. 
 
Priority Level 1 – Manual override has a priority of one, which means it replaces all  
other categories as the active current source whenever activated. 

 Regional Event 
This signal control source category can be initiated via the Transparity Center-to-Center (C2C) 
interface by a regional partner such as a Department of Transportation (DOT) that has legal 
jurisdiction over multiple agencies (e.g. FDOT and the Pensacola and Escambia agencies). This 
allows a DOT to join and coordinate the traffic Controllers on arterials belonging to multiple agencies 
to increase throughput for a disaster or sporting event. 
 
Priority Level 2 – The regional event signal control source category has a priority of two which is 
higher than the category priority for the special events category, the traffic commands category, and 
the central schedule category. 

 Special Event 
This signal control source category can be initiated via the Transparity TMS Scheduler by an agency 
if they need to coordinate the traffic Controllers on an arterial for a sporting  
event or disaster in the region which they have jurisdiction over. 
 
Priority Level 3 – The special event signal control source category has a priority of three which is 
higher than the category priority for the traffic command and central schedule categories, 
respectively. 

 Traffic Command 
This signal control source category can be initiated via the Transparity TMS Scheduler by an agency 
when they want to place a contiguous group of Controllers into an Adaptive, or Responsive mode. 
 
Priority Level 4 – The traffic command signal control source category has a priority of four which is 
higher than the category priority for the central schedule category. 

 Central Schedule 
This signal control source category can be initiated via the Transparity Scheduler by an agency to 
send a pattern to a traffic Controller or group of traffic Controllers. 
 
Priority Level 5 – The central schedule signal control source category has a priority of five making it 
the lowest category priority and as such, must wait for all other categories to complete before it can 
execute its pattern as the current source. 

6.5 GROUP PATTERN CONTROL 
The Group Pattern Control window is similar to Signal Pattern Control; however, it details 
 the current operational status for a Group of intersections rather than an individual intersection. 
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This window enables users to confirm the operational pattern of each intersection within a group. 
Execution of Manual Override from this display issues a Manual Override Pattern to each intersection 
within the group. 

 

Figure 6-13: Group Pattern Control 

6.6 TIME/DATE BROADCAST 
The current time and date can be sent to a single traffic Controller, or multiple traffic con- trollers that 
belong to a coordinated control group: 

6.6.1 Single Traffic Controller Broadcast 
1. To broadcast the Time/Date to a single traffic Controller: Device Explorer > 

Traffic Controllers dropdown menu > Operations > Broadcast Time/Date. 

Figure 6-14: Single Controller Time / Date Broadcast 

2. Right-click on the desired Traffic Controller to launch the sub-context menu. 

3. Select Operations from the sub-context menu. 

4. Select Broadcast Time/Date. 



Transparity® TMS – User Manual 

Version 1.7.3 Page 147 of 228 

 

 

Figure 6-15: Single Controller Time / Date Broadcast 

5. Click on the Broadcast button on the Time/Date Pop-up Box to 
send the current Time/Date to the Traffic Controller. 

6. Close the Broadcast Time/Date Pop-up Box. 

6.6.2 Broadcast Time/Data to Individual Controllers 
Table 6-14: Broadcast Time/Date to Single Controllers 

Broadcast button After selecting the Traffic Controller, the user wishes to send a time/date 
broadcast to, the ‘Broadcast button’ is selected to actuate the 
transmission. 

 

Name 

This is the name of the Traffic Controller for whom the user wishes to send 
the Time/Date Broadcast. The field is automatically populated when the 
user initiates the sub-context menu from the traffic Controller located 
under the ‘\\Traffic Devices\Traffic Controllers’. 

 

Type 

The type of traffic Controller. The field is automatically populated when 
the user initiates the sub-context menu from the traffic Controller located 
under the ‘\\Traffic Devices\Traffic Controllers’. 

Protocol The NTCIP protocol used to communicate with the Traffic Controller. 

Description This contains the non-required description of the Traffic Controller. 

Close button 
After the Time/Date Broadcast has been sent, the user can close the pop-
up window. 

6.6.3 Multiple Traffic Controller Broadcast 
1. To broadcast the time/date to multiple traffic 

Controllers that belong to a coordinated control group: 
Communications > Broadcast Time/Date Menu. 
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Figure 6-16: Multiple Controller Time / Date Broadcast 

2. Launch the Broadcast Time/Date coordinated control group pop-up box. 

3. Select all control groups. 

OR 
 

2. Select specific control groups for the broadcast. 

3. Click on the Broadcast button to send the current Time/Date to the 
selected Traffic Controller Group(s). 

4. Close the Broadcast Time/Date Pop-up Box. 
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6.6.4 Broadcast Time/Data to Selected Groups 
Table 6-15: System Administration – Broadcast Time/Data to Select Groups 

All Controllers Selecting this radio button will send the time/date broadcast to all Controllers 
listed in the Available Groups pane. 

Select Groups 
Selecting this radio button will send the time/date broadcast to select 
Controller groups. 

Filter 
A filter can be applied to help locate ‘Available Groups’ or Traffic Controllers, 
or “Selected Groups’ of Traffic Controllers. 

Traffic Controller 
Groups 

Traffic Controllers Groups can be moved from the ‘Available Groups’ pane to 
the ‘Selected Groups’ pane to enable them to receive Time/Date 
Broadcasts. 

Broadcast button 
After selecting the Controller groups, the user who wishes to send a 
time/date broadcast to the ‘Broadcast button’ is selected to actuate the 
time/date transmission. 

Close button 
After the Time/Date Broadcast has been sent, the user can close the pop-up 
window. 

 

6.7 REMOTE DOWNLOADS 
Transparity TMS and supporting local Controller software permit users in the field to request a 
download of all timing parameters from the central system. This feature is referred to as “Remote 
Download." 
 
During the remote download process, users of Transparity TMS are not permitted to update device 
timing (i.e. upon launching the Timing Editor the user is in “read only” mode). Once the process is 
complete, the activity lock on the select Controller is removed. 
 
The instructions below provide guidance for requesting a remote timing download for  
each local Controller program type: 

6.7.1 McCain Omni eX (version 1.9 and later) 
1. From the Controller Front Panel navigate to: B. MISCELLANEOUS > 2. DB 

MANAGEMENT > 2. REQUEST DOWNLOAD 
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2. Press Y to confirm the request 

     Figure 6-17: Omni eX Front Panel view through PuTTY 

3. Omni eX will now wait for central to receive the request and begin 
the download. During this time, a timeout will be displayed on the 
screen. 

4. Once the download is complete, the Front Panel will indicate DOWNLOAD 

COMPLETED. Press ESC to return to Download Menu. 
 

   Figure 6-18: Omni eX Download Complete 

6.7.2 McCain 2033 
Supported version numbers are McCain 2033 RV, and McCain 2033 NY. From the Controller Front 
Panel: 
 

1. From the Main Menu navigate to (9) Utilities. 
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2. Select Option D for Automatic Download. 

3. Select YES to initiate the download. 

4. The Front Panel will show “Download in Progress.” 

5. Upon completion, the front panel will indicate “Download Complete.” 

6.7.3 170 Programs (McCain 223, McCain 233 RV, McCain 233 MC) 
Supported version numbers are McCain 233 RV 2.1E, and McCain 233 MC 1.H. From the Controller 
Front Panel: 

 

1. Access memory location: C\0+0+4. 

2. The Front Panel shall indicate a value of zero (0), by default. 

3. Enter any value other than zero into the C\0+0+4 memory location. 

4. The Front Panel shall indicate a value of 255 once the 
download process is initiated. 

5. The Front Panel will indicate a value of zero (0) upon completion of the timing 
download. 

6.3.2 Disable Remote Downloads 
Transparity TMS provides a way to disable administratively at a system level the functionality to 
respond to such requests from the field devices. This is useful for administrators who wish to have 
more control over how and when timing is managed. 

 

1. Open Application Options and navigate to Devices. 

 

Figure 6-19: Disable Remote Downloads 

2. Select Disable remote downloads. 

3. Click Save. 
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6.8 SERVICE TASKS 
The Transparity Service Task window is used to create tasks for certain types of efforts that 
require scheduling and tracking to ensure they are started and completed by  
an established start and due date. 

6.8.1 Create a Task 
This window allows the user to enter all pertinent data related to a task they wish to schedule. 

 

1. To create a service task: Home > Management > Tasks > Create Task. 

2. Click each of the expand buttons to ensure all entries are 
complete. All fields marked with a red dot are mandatory. 

3. Select the Type of the service task you would like to create. 

4. Click Save after entering all required data into the ‘Create Service Task” window. 

 

Figure 6-20: Select Task Type 
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Figure 6-21: Create Service Task 

6.8.2 Task Properties 
Table 6-16: Create Task Properties 

Name Name assigned to the Service Task (i.e. Field Master Preventative 
Maintenance Service Task) 

 

 
Type 

The type of service task being created: 

• Maintenance 

• Incidence Response 

• Engineering 

• Other 

• Detector Maintenance 

Start Date The weekday, month, month day and month year a service task is to 
start. 

Due Date The weekday, month, month day and month year a service task is to be 
completed. 

 

 

Priority 

The priority, or urgency assigned to the completion of the service task. 
The user can select from three levels of priority: 

• Low 

• Normal 

• High 
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Created By Designates the User that created the service task. 

Assigned To 
Launches a window that contains a list of users that can be assigned 
the service task. 

Associated Device 
The name of the traffic Controller, or field master that the service task is 
being created for. 

Created Date 
The weekday, month, month day and month year a service 
task is being created on. 

 
Last Modified 

The last weekday, month, month day and month year a service task 
was modified using the ‘Edit Service Task – Incident Response Service 
Task’ interface. 

Completed Checkbox 
When a service task has been completed a checkmark is 
placed into the completed check box 

 

6.8.3 Task Summary 
The Service Task Summary allows users to view and filter through existing service tasks. It also 
provides an easy interface for creating, editing, and deleting. 

 

1. To access the Schedule Summary: Home > Tasks > Task Summary 

2. Use buttons Create, Edit, or Delete. 

3. Right-click on a summary item, or select one of the summary 
buttons enables the following capabilities: 

• Create a Task, 

• Edit (Selected) Task, 

• Delete (Selected) Task. 

4. Use the Filter to search and isolate a particular schedule profile(s). 
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Figure 6-22: Task Summary with Upcoming Tasks Pane Open 

6.8.4 Upcoming Tasks 
The Upcoming Tasks window allows users to view existing service tasks. 
 

1. To view the Upcoming Service Tasks: Home > Management > Tasks > 
Upcoming Tasks. 

2. In the bottom workspace of the Create Task window the user 
may observe all                     completed and uncompleted Upcoming Tasks. 

3. Tasks can be added and deleted in the Upcoming Task interface using the 
‘Create Task’ and the ‘Task Summary’ interfaces and the following commands: 

• Edit (Selected) Task. 

• Delete (Selected) Task. 

Figure 6-23: Service Task Upcoming Tasks 
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7.  COMMAND PROFILE 
Command Profiles are configuration records describing some advanced traffic operation, i.e. forms of 
intersection coordination above and beyond what basic static intersection coordination configuration 
allows. There are three types of Command Profiles: Traffic Responsive, Basic Adaptive, and 
Advanced Adaptive.  
 
Traffic Responsive, is an older style of advanced traffic operation.  Instead of changing the cycle 
length and offset dynamically within a coordination plan, it can change coordination plans based on 
changing traffic volume (not speed).  It doesn't have the fine tuning that Adaptive has, but if volumes 
drastically change, Traffic Responsive is better suited to adjusting. This is because it can change 
coordination plans which can be configured quite differently, whereas Adaptive just adjusts 
incrementally with an upper bound on how much it can adjust per cycle. 
 
Adaptive is a traffic management strategy in which traffic signal timing changes, or adapts, based on 
actual traffic demand. This is accomplished using an Adaptive traffic control system consisting of both 
hardware and software. ADAPTIVE provides a set of tools that can be used to achieve Adaptive 
operations that adjust cycle length, splits, and offsets to real time trends in traffic. These tools use 
Adaptive profiles, which are a strategy that can be scheduled to run on a selected group of controllers.  
 
There are two types of Adaptive profiles. 

 

A basic Adaptive system adjusts cycle lengths, offsets, and splits based on demand as measured from 
standard detectors at individual intersections. The basic Adaptive profile does not require system 
detection. This type of profile starts by implementing a user configured base pattern and then 
incrementally adjusting the splits, offsets, and cycle length. 
Basic Adaptive is sometimes referred to as Traffic Adaptive.  It is a form of intersection coordination 
run around peak traffic hours to dynamically adjust the preconfigured cycle times so that as speed 
changes on a major street, the coordination plans adjust so that you can still make green lights, or that 
side streets aren't waiting overly long times for service. 
 
 An advanced Adaptive system uses the same split and cycle length calculation routines as the basic 
Adaptive system. The advanced system differs from the basic Adaptive system in that it uses system 
detectors to monitor for sudden changes in traffic volumes and directionality. 
 
Between Basic and Advanced Adaptive, Advanced has more requirements in terms of up-front 
configuration and detection at the intersection. This is also where Advanced Adaptive shines.  It grew 
from the realization of the limitations of traditional (i.e. Basic) Adaptive and Traffic Responsive.  Not 
only does Advanced Adaptive require more detection than Basic, but it actually does a form of Traffic 
Responsive as well.  It adjusts cycles and offsets within thresholds.  But if a threshold (volume of traffic 
between intersections) changes drastically enough, it will call for a new coordination plan.  In this way, 
you get the best of both worlds. 
 
The Transparity Command Profile walks the user through a series of setup steps to capture all the 
necessary configuration data to create a Command profile. 

7.1 INITIAL CONDITIONS 
Robust communications are critical to the optimal performance of the Adaptive system. Make sure all 
Controllers are online and communicating in Transparity. 
 
Timing: Make sure the timing in the system matches the timing in the field. The group that runs 
Adaptive should have at least one coordination pattern to use as a starting point, where all 
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Controllers use the same pattern # and have the same cycle length. 
 
Detection: Critical to the optimal performance of the Adaptive system. All detectors at each 
intersection should be identified by phase, location, approach, and lane, (i.e. Vehicle Detector 2 = 
Phase 2 EB Advance, lane 1). 
 
System Detectors are used to monitor traffic volumes that are in a location where we get the best 
indication of traffic volume and speed on the corridor. 

7.1.1 Detection 
Map out your detectors at each intersection. The ideal detection for Adaptive is advanced 
detectors for through lanes, one discrete input per lane. If advanced detection is not available, limit 
line can be used. 
 
Identify detectors on the corridor that can be used as System Detectors. For the best performance 
these should be midblock or advanced detectors on discrete inputs. 
 
Designating Adaptive Detectors: Open the Timing Editor and go to the Vehicle Detectors page. 
Check the detectors which have been identified as Adaptive detectors (ideally, advanced detectors). 

 

 

Figure 7-1: Designating Adaptive Detectors 

7.1.2 Adaptive Group 
1. Select: Groups > Create Group.  
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  Figure 7-2: Create Group 

2. Name the Group and select Type Adaptive. 

Figure 7-3: Select Type Adaptive 

3. Add Controllers to the Group. 

  Figure 7-4: Add Controllers to the Group 

7.1.3 Create Arterial Route 
1. Select: Arterial > Arterial Route Builder. 

  Figure 7-5: Create Arterial Route 

 

2. Select the Controllers in your group along the corridor to be 
added to the Arterial                         Route in order. The selected Controllers 
(Arterial Route Nodes) will turn blue. 
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Figure 7-6: Select Controllers in Group 

3. As you select the Nodes in order, the Route Builder automatically 
creates Forward                           System Links on the left side. 

 

Figure 7-7: Create Forward System Links 

4. Open the Details Pane by clicking the grey ribbon at the bottom of the 
Window. 

   Figure 7-8: Open Details Pane 

5. Arterial Route Properties: Here you can name the Route. 
Make sure to select Two-Way. When Two-Way is selected it will 
create Reverse System Links. 

6. Route Item Properties: As you click on Links on the left side 
above, you have the opportunity to select the Movement, Direction, 
Lanes, Design Speed, Capacity, and Length (in feet). You can 
also set Congestion Properties and Assign Detectors to the Link, 
but it is not necessary for Adaptive. 
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Figure 7-9: Select Route Properties 

7. Arterial Route Movements: An Arterial Route Movement specifies 
the phase (or overlap) that is traversed through when travelling 
from one system link to the next. 

 

Figure 7-10: Arterial Route Movements 

8. Save the Arterial Route. 

7.1.4 Create System Detectors 
1. Click Create System Detector under Data Collectors. 

     Figure 7-11: Create System Detector 

2. Name the Detector and select the appropriate Controller. Assign 
the detector number in the Controller that is associated with the field 
detector. 
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Figure 7-12: Name the Detector 

3. Location can be left blank unless you want an icon on the map. 
Assign the Movement, Direction, Detector Type, and Lane. Lane 
Capacity relates to what is used as 100% Threshold. This number is 
multiplied by the Weighing Factor. Thresholds can be set to determine 
a reasonable range for valid data (usually left default). 

 

Figure 7-13: Configure Detector 

4. To run Advanced Adaptive there must be at least 4 system 
detectors (2 per  direction). 

5. Any Controller detector using a system detector must be configured for Volume 
and Occupancy in the Controller timing. 

   Figure 7-14: Configure Volume and Occupancy 

7.1.5 Configure the Tru-Traffic Diagram 
1. First, create the a KML file in Google Earth. 

2. Under Places > Right click My Places > Add > Folder. 
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Figure 7-15: Add Places Folder 

3. Once you have added and named the folder, click Add 
Placemark to begin adding intersections. 

 

Figure 7-16: Add Placemark 

4. Add a Placemark at each intersection in your corridor and name it 
appropriately. Once all placemarks have been added, use the 
Places section on the left to drag the new place marks into the 
folder you created in the previous step. Right Click on the folder 
and Save Place As. Name the file and save as type KML. 

7.1.6 Tru-Traffic 
1. First make sure each Controller in your corridor is assigned a 

unique Tru-Traffic Id. 
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Figure 7-17: Assign Tru-Traffic ID 

2. If not installed on the server already, download and install the 
latest Tru-Traffic software from www.tru-traffic.com. Make sure 
you obtain a valid license. 

 Creating the Tru-Traffic DGM File 

1. Open Tru-Traffic and go to File > Open. Select type KML and 
open the file you created. 

2. Connect dots to create arteries or click Automatically Trace Routes and 
Create. 

 

Figure 7-18: Create Arteries 

3. Click on View Network Parameters. 

Figure 7-19: View Network Parameters 

4. Set the Cycle Length (this should match the cycle length of 
the Adaptive base pattern). 

  

http://www.tru-traffic.com/
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Figure 7-20: Set Cycle Length 

5. Click on View Outline. 

   Figure 7-21: View Outline 

6. Click on the first intersection in the Arterial Outline. 

   Figure 7-22: First Intersection 

7. Set the Id Number (this should match the TruTraffic Id in 
Transparity). Set the Reference Point to Start of first through 
movement yellow. Choose one of the intersections in the corridor 
to have Offset Locked. 
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Figure 7-23: Configure ID Number 

8. Open the Timings tab and set the phasing and split times. It helps to have the 
Group Timing Editor open. 

 

Figure 7-24: Configure Phasing and Split Times 

9. Go to the Green Bands tab and set the Speed to your desired 
speed. The other tabs are not necessary. 
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Figure 7-25: Set Speed 

10. Repeat for each intersection in the arterial. Once all changes 
have been applied,               save the file as type DGM. DGM files should 
be saved to the Transparity Data folder. 

7.2 ACCESS THE COMMAND PROFILE 
7.2.1 Create Command Profile 

1. To access the Command Profile wizard, select: Devices & Displays > Arterial 
> Create Command Profile. 

 

Figure 7-26: Create Command Profile 

2. Use the wizard to walk through adding the necessary data to 
create a new Command Profile. Users may easily return and 
update any of these later. 
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Figure 7-27: Create Advanced Adaptive Profile 

3. Use the wizard to walk through adding the necessary data to 
create a new Basic Advanced, Traffic Responsive, or 
Advanced Adaptive Profile. Users may easily return and 
update any of these later. In this example, we create an 
Advanced Adaptive Profile. 

4. Complete the General fields 

a. Name: Create a name for the Advanced Adaptive Profile. 

b. Group: The control group created to represent the 
traffic Controllers included in the Advanced Adaptive 
Profile. 

c. If desired, include a brief Description to help better identify the profile. 

5. Click Next. 

 

Figure 7-28: Create Advanced Adaptive - General 
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7.2.2 Advanced Adaptive Properties 
1. Enter the appropriate data in the Advanced Adaptive Properties window fields: 

a. Max. Cycle Delta (sec): Max # of seconds the cycle length 
can change from previous. Default = 15 seconds. 

b. Consecutive Max Count: # of times a phase must consecutively max 
out/force off before requesting more time. 

c. Consecutive Gap Count: # of times a phase must 
consecutively gap out before requesting less time. 

d. Optimal Gap Range (%): percentage of the split time in which 
a gap out is recognized for requesting a decrease, i.e. an 
Optimal Gap Range of 90% means that a gap is not 
considered for a split decrease if it happens within the last 10% 
of the split. Default = 90%. 

e. Adaptive Phase Step (sec): max # of seconds by which the split can be 
increased/decreased. Default = 4. 

f. Cycle Update Interval (#): minimum # of consecutive cycles 
between cycle changes. Default = 1. 

g. Offset Mode: 
i. Locked Pattern Offsets: The offsets do not change from the offsets in the 

base pattern. 

ii. Optimize – Fixed PWF: The Tru-Traffic diagram uses a fixed Progression 
Weighting Factor. 

iii. Optimize – Calc PWF: The Tru-Traffic DGM calculates 
PWF based on Flow1/Flow2 detectors. McCain Offset 
Optimization, or Tru-Traffic© Offset Optimization. 

2. Tru-Traffic Diagram (if applicable): Browse to the diagram 
previously created – you may need to add as a resource. 
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Figure 7-29: Advanced Adaptive - Properties 

3. Click Next. 

7.2.3 Detector Data 
1. Select: Detector Data 

a. Calculation Source. 

b. Volume Capacity %: percentage of the Lane Capacity 
value configured in Detector Configuration. 

c. Weighted Occupancy: percentage of Sys Detector Occupancy. 

d. V+kO: Volume + (occupancy times a constant (k)). 

e. Data Sample Mode: Average of all system detectors per 
flow or Highest system detector. 

f. Data Sample Period: How often the data is aggregated and used for 
calculation. 

g. Detector Fail Action: Determines what happens upon 
detector failure. Historical Data is last known good data, 
Terminate Adaptive returns the corridor to base pattern, 
Suspend Adaptive retains last Adaptive cycle and offset. 

h. Detector Fail Timeout: # of minutes a detector is in a failed state before the 
Detector Fail Action is applied. 
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Figure 7-30: Advanced Adaptive – Detector Data 

2. Click Next. 

7.2.4 Flow One and Flow Two - Detectors 
Flow One and Flow Two – Detectors: First, select the flow direction. Add the correct system 
detectors. You must have at least 2 Valid Detectors per flow. If the number of valid detectors drops 
below the Valid Detectors Threshold or if one of the detectors flagged as Critical has failed, the 
detector fail action is taken. 

 

Figure 7-31: Flow One and Flow Two - Detectors 

7.2.5 Thresholds 

1. Click the Add Threshold  button to add 
additional thresholds to the increasing or decreasing percentages. 

2. Increasing: Threshold percentages entered by the user and the 
pattern numbers the user wishes to assign to them for increasing 
traffic volumes or occupancy levels. When the Flow One or Flow 
two detectors reach the configured percentage (defined by the 
Calculation Source configured in Detector Data) the specified 
pattern is commanded. Whenever a threshold is crossed, the 
system jumps to the base pattern specified and that base pattern 
begins to adapt from there. This allows the system to make cycle 
changes greater than the previously configured cycle max delta 
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when volumes or occupancy change quickly. The highest Flow is 
used. The cycle increase is limited to the max cycle value specified. 

1. Decreasing: Threshold percentages entered by the user and 
the pattern numbers the user wishes to associate with them for 
increasing traffic volumes or occupancy levels. When the Flow One 
or Flow 2 Detectors drop below the configured percentage the 
specified pattern is commanded. It is advisable to use hysteresis by 
setting the decreasing threshold for a pattern to less than the 
increasing threshold for the next highest pattern to prevent the 
system from toggling back and forth if the measured data hovers 
around the threshold value. 

2. %: This indicates at what volume or occupancy level the 
pattern associated with it will be set as the current pattern running 
for all the traffic Controllers in the Traffic Responsive control group. 

3. Pattern: Use the dropdown menu to select the pattern to be associated with 
the threshold percentage. 

4. Max: Cycle (sec): A number that represents the maximum cycle size in 
seconds. 

5.  Deletes a threshold. 

Figure 7-32: Advanced Adaptive Pattern Command Profile –Thresholds 

6. Click Next. 

7.2.6 Minimum Splits 
For each Controller in the group this sets the lowest possible split that each phase can 
 be reduced to in Adaptive. It is important to make sure the Min Split is not greater than the actual split 
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in the Adaptive base pattern. It is helpful to have the Group Timing Editor open to verify split times. 
Also, it is important that the sum of split times for concurrent ring barrier groups add up to the same 
value, i.e. the sum of phases 1 & 2 should add up to the same as the sum of phases 5 & 6. 
 

1.  Select Minimum Splits. 

2.  Group: Pre-populated with the Adaptive Group selected in the General window. 

3.  Controllers: Pre-populated with the traffic Controllers that comprise the Adaptive 
Group selected in the General window. 

4.  Phase: Phase 1 through 8 is listed. Minimum Split values are listed for each. 

5.  Min. Split (sec): User enters the minimum split level for each phase (1 through 8) 
for each traffic Controller contained in the Controllers pane in the Splits window. 

6.  Min. Cycle Time (sec): Displays the minimum cycle time value rollup for all 
phases (1 through 8) on each traffic Controller displayed in the Controllers pane 
in the Splits window. 

Figure 7-33: Advanced Adaptive – Minimum Splits 

7.3 CREATE THE SCHEDULE 
1. Select: Schedule > Create Schedule from the Home menu. 



Transparity® TMS – User Manual 

Version 1.7.3 Page 173 of 228 

 

 

 

Figure 7-34: Create Schedule - Category 

2. Select Run Traffic Command. 

Figure 7-35: Run Traffic Command 

 Run Traffic Command 
1. Name the Schedule, select Recurring TOD and DOW and make 

sure the schedule is Enabled. 

2. Set the Days of Month, Months of Year and Days of Week, as well as the start 
time and end time. 
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Figure 7-36: Schedule - Run Traffic Command 

3. Action: Select the Traffic Command Profile that was previously 
created and set the Priority. If multiple traffic command profiles are 
active for a certain group at the same time, the Traffic Command 
with the highest priority will be the active one. 

 

Figure 7-37: Action - Run Traffic Command 

7.4 RUN ADAPTIVE MANUALLY 
1. Select Schedules > Schedule Summary. 
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2. To immediately start the Adaptive profile, click on the schedule 
the runs the command profile and select Run Schedule. 

7.5 TERMINATE ADAPTIVE MANUALLY 
1. Select Settings in upper left corner next to Home and go to Processes. 

2. Select the process that corresponds to the Command Profile 
and click End Process. 

7.6 OBSERVING ADAPTIVE OPERATIONS 
7.6.1 Command Profiles Summary 

The Command Profiles Summary allows users to view a summary of all existing Com- mand 
Profiles as well as the basic information that describes the parameters that define their use. In 
addition, profiles may also be easily added, edited, or removed from this view. 

1. Select Devices & Displays > Arterial > Command Profiles Summary. 

2. All Command Profiles are listed in order by name 

3. The default view also showcases the Profile Type (i.e. Advanced 
Adaptive, Traffic Responsive, or Basic Adaptive Pattern), name of 
the Controller Group, and any description information provided. 

4. Use the Filter to search and isolate a profile(s). 

5. From this view, users may easily create, edit, or delete existing 
profiles by selecting a command profile from the list and then 
click the button that corresponds with the desired action. 

 

Figure 7-38: Command Profiles Summary View 
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7.6.2 Command Profile Display 
The Command Profile Display plots a trend line that indicates what the traffic volume or occupancy 
percentage and is based on the last pattern update interval. Hovering the cursor over a plot point 
displays pertinent information related to the plot point. 

 

1. To access the Command Profile Display: Devices & Displays > Arterial > 
Command Profile Display 

2. Select the Adaptive Command Profile you wish to observe, as well as the Date, 
Time, and Duration. 

3. If the Adaptive Profile is Advanced Adaptive you can select Cycle Length or 
Pattern Threshold. 

4. Click Update Diagram after selecting the Command Profile and 
Date/Time/Duration. 

5. Checking the Real Time box causes the display to automatically update once 
every cycle. 

7.6.3 Cycle Length Display 
Selecting Cycle Length under Display on the Command Profile Display screen plots a trend line in 
black that indicates what the cycle time is at a given point within the start and stop time selected for 
observation. Hovering the cursor over a plot point displays pertinent information related to the plot 
point, as seen in Figure 7-39 below. 
 
The display is updated once per cycle, at the Master Cycle Zero point. Clicking on any dot in the 
display shows the calculation results for that cycle. It also shows the max cycle and min cycle for the 
current Adaptive pattern. 
 
The lower Data portion of the display shows what the calculated cycle time is for the chosen 
master cycle zero time. For that calculation point, it shows each Controller’s cycle request, current, 
and next offset, and whether the Controllers were in Transition or Preemption. A Status of Active 
means that the Controller’s Adaptive split calculation routine is running and Adaptive is engaged. 
Active Pending means the Controller has suspended split adjustment and is attempting to get back 
into active mode (usually due to recovery from a transition or preemption). Unknown means the 
Controller is not communicating. 
 
Error Cycle or Error Split means that there was an error in the calculation; normally, this is due to a 
miscalculation when setting up the Min Splits. 
 
Clicking on any Controller in the list will bring up the split calculation display on the right side. This will 
show for each phase what the previous Adaptive split was versus what the phase used, and the 
minimum split. Demand shows whether the demand has increased or decreased based on gap/max 
out. Trend shows once a phase has reached its consecutive max count or consecutive gap count. If 
an upward trend has been established, the system will increase the split time for that phase. Likewise, 
a decreasing trend decreases the split time. The new split time shows up in the Issued column. 
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 Figure 7-39: Adaptive Display - Cycle Data 

7.6.4 Pattern Threshold Display 
If running Advanced Adaptive mode, selecting Pattern Threshold under Display in the Command 
Profile Display screen shows the results of the system detector calculation. Each dot in the diagram 
corresponds to a calculation point (based on what was configured for Data Sample Period). The 
calculation point shows the percentage of the Lane Capacity value configured in Detector 
Configuration. This value is either the average of all flow detectors, or the highest of all flow detectors 
depending on what is configured in the profile. The calculation for each flow is shown. 
 
You can observe where the calculation falls with respect to the configured thresholds for each pattern 
change. The yellow dotted lines represent increasing thresholds, while the blue dotted lines represent 
decreasing thresholds. 
 
The data section below shows the primary directional flow for each calculation point, as 
well as the associated Pattern. The percentage of lane capacity for each flow is shown. The 
difference between flow one % and flow two % is used to determine the primary direction, as well as 
directional volume %. 
 
The right display shows the data collected for each detector. The VOS period is configured in the 
Controller timing in Log Configuration. 
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Figure 7-40: Pattern Threshold Display 

7.6.5 Command Profile Logs 
Refer to “Command Profile Log" on page 184 for details on viewing logs related to Command 
Profile operations. 
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8.  ADVANCED SIGNAL PERFORMANCE 
MEASURES 

Transparity TMS provides a mechanism for collecting and storing log data from the traffic Controller in 
addition to formatting the data and producing reports. 
 
This section provides an overview of: 

 

• "Use the Reports Interface" below 

• "System Reports" below 

• "Device Log Files" on page 183 

• "Time-Space Diagram" on page 188 

8.1 USE THE REPORTS INTERFACE 
Transparity Reports allow users to select from a list of pre-configured reports. When a report is 
selected from the Reports menu, the user may customize the report data (such as desired traffic 
Controllers or detectors) and to select the desired date range. 

 

8.2 SYSTEM REPORTS 
8.2.1 Split MOE Report 

This report shows the time of each phase. 
 

1.  To create the report: Reports & Logs > Reports > Split MOE Report. 

2. Click the File icon to locate the desired Controller. 

3. Double-click the desired traffic Controller. 

4. Enter a Start Time and End Time. 

5. Click Run. 

 

Figure 8-1: Running a Split MOE Report 
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8.2.2 System Detector VOS Report 
This report shows all VOS data collected by the system 

1. To create the report: Reports & Logs > Reports > System Detector VOS 
Report 

2. Select the desired traffic Controller(s). 

3. Move the Controller(s) from Available Detectors > 
Selected Detectors by using the arrow buttons. 

 

 

 

 

   Figure 8-2: :System Detector VOS Report 

4. Select the desired View from the dropdown menu – occupancy 
(%), speed (mph), or volume (counts). 

5. Select a Period (in minutes) from the dropdown menu. 

6. Enter a Start Time and End Time. 

7. Click Run Report. 

8.2.3 Link Detector VOS Report 
This report shows all VOS data collected for a set of links. 

1. To create the report: Reports & Logs >Reports > Link Detector VOS 
Report. 

2. Select the desired link(s) by clicking Add Links. 

3. Select the desired View from the dropdown menu – 
occupancy (%), speed (mph), or volume (counts). 

4. Select a Period (in minutes) from the dropdown menu. 

5. Enter a Start Time and End Time. 

6. Click Run Report. 
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Figure 8-3: Link Detector VOS Report 

8.2.4 Speed Trap Report 
This report shows all Speed Traps collected by the system. 

 

1.  To create the report: Reports & Logs >Reports > Speed Trap. 

2. Select the desired Speed Trap(s) by clicking Add Speed Traps. 

3. Select a Period (in minutes) from the dropdown menu. 

4. Enter a Start Time and End Time. 

5. Click Run Report. 
 

Figure 8-4: Speed Trap Report 

8.2.5 Turning Movement Count 
This report is part of a traditional Traffic management solution, so it is included in the Transparity 
desktop menus. It is a hyperlink to a report in the Web UI. 
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Figure 8-5: Turning Movement Count Report 

8.2.6 Peak Hour 
This report is part of a traditional Traffic management solution, so it is included in the Transparity 
desktop menus. It is a hyperlink to a report in the Web UI. 

 

Figure 8-6: Peak Hour Report 
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8.2.7 BlueTOAD Travel Time Report 
This report shows the BlueTOAD Travel Time collected by the system. 

 

1. To create the report: Reports & Logs >Reports > BlueTOAD Travel Time. 

Figure 8-7: BlueTOAD Travel Time Report 

8.3 DEVICE LOG FILES 
8.3.1 Traffic Controller MOE Log 

1. To view the log, select: Reports & Logs > Logs > Traffic Controller MOE. 

2. Select the desired traffic Controller. 

3. Enter a Start Time and End Time. 

4. Click Run. 

Figure 8-8: Traffic Controller MOE Log 

8.3.2 Traffic Controller Log 
1. To view the log: Reports & Logs > Logs > Traffic Controller. 

2. Click the folder button to locate the desired Controller. 

3. Select the desired traffic Controller. 

4. Click OK. 

5. Enter a Start Time and End Time. 

6. Click Run. 
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Figure 8-9: Traffic Controller Log 

8.3.3 Command Profile Log 
1. To view the Command Log: Home > Reports > Command Profile Log. 

2. Select the desired Command Profile. 

3. Enter a Start Time and End Time. 

4. Select the Run button. 

5. Use Filter (see expansion arrow) to refine search. 

A. Select the Print button to print the summary listing. 

B. When you click the Print button on any summary page, 
you get an options                             window before the Print Preview 
generates. On the Styles page, you can see the header 
background and foreground options. 

 

Figure 8-10: Print Options 

You can see them applied on the print preview. 
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Figure 8-11: Print Preview 
 

  
Figure 8-12: Command Profile Log 

8.3.4 Command Threshold Log 
1. To view the log: Home > Reports > Command Threshold Log. 

2. Select the desired Command Profile. 

3. Enter a Start Time and End Time. 

4. Use Filter (see expansion arrow) to refine search. 

5. Select the Run button to generate the Command Threshold Log. 

6. Select the Print button to print the summary listing. 
 

Figure 8-13: Command Threshold Log 

8.3.5 Activity Log 
1. To view the log: Home > Reports > Activity Log. 

2. Enter a Start Time and End Time. 

3. Select the Run button to generate the Activity Log. 
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4. Use the Filter to search and isolate a particular profile (See 
expansion arrow in graphic below). 

5. Select the Print button to print the summary listing. 
 

 

  Figure 8-14: Activity Log 

8.3.6 Comm Error Log 
1. To view the log: Home > Reports > Comm Error Log. 

2. Select the desired traffic Controller. 

3. Enter a Start Time and End Time. 

4. Click Run. 

5. Use the Filter to search and isolate a particular profile. 

6. Select the Print button to print the summary listing. 
 

Figure 8-15: Comm Error Log 

8.3.7 Vehicle Detector Speed Log 
1. To view the log: Reports & Logs > Logs > Detector Speed. 

 



Transparity® TMS – User Manual 

Version 1.7.3 Page 187 of 228 

 

 

 

     Figure 8-16: Detector Speed Log 

1. Click the folder button to locate and select the desired traffic Controller. 

2. Click OK. 

3. Enter a Start Time and End Time. 

4. Use Filter to refine search. 

5. Click Run. 

6. Select the Update Speed Data button to update the data. 

 

7. Select the Print .button to print the summary listing. 

8.3.8 Vehicle Detector VOS Log 
This report shows collected volume, occupancy, and speed (VOS) data. 

1. To view the log: Reports & Logs > Logs > Detector VOS. 

2. Click the folder button to locate the desired traffic Controller. 

3. Select the desired traffic Controller. 

4. Click OK. 

5. Enter a Start Time and End Time. 

6. Use Filter to refine search. 

7. Click Run. 

8. Select the Update VOS Data button to update the data. 

9. Select the Print button to print the summary listing. 

10. Click Run. 
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Figure 8-17: Detector VOS Log 

8.4 TIME-SPACE DIAGRAM 
The Time-Space Diagram is a critical tool for Traffic Engineers in the ongoing operation of a traffic 
management center. It illustrates the bandwidth of coordinated movements over distance and time. In 
Transparity TMS, users may view the bandwidth of real-time status, historical data, or programmed 
signal timing data. 
 
To open the Time-Space Diagram: Arterial > Time-Space Diagram. 
 
Usage of the Time-Space Diagram assumes the user has already created a route using the Arterial 
Route Builder. This ensures the proper links and movements are used in plotting the used or 
programmed green times. 

8.4.1 Use the Time-Space Diagram Interface 
The Time-Space Diagram view is made up of two regions: a top horizontal para meters “header” bar 
and the main body directly below, used to visualize the green time for the phase movements specified 
in the arterial route. 

 

  
Figure 8-18: Time-Space Diagram 
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The header bar parameters change based on the mode in which the Traffic Engineer wishes to work; 
that is, based on the Data Source selected, parameters may be hidden or shown. In all cases the 
Arterial Route and Data Source parameters are shown and required. 

 Parameters for Programmed Data Source 
With this option checked, Pattern becomes a required parameter, displayed as a drop-down of 
available patterns. Parameters for other Data Sources are hidden. 

 

 
Figure 8-19: Dropdown of Available Patterns 

 Parameters for Historical (MOE) Data Source 
With this option checked, Start Date, Start Time, and Duration become required parameters. 
Parameters for other Data Sources are hidden. Start Date default value is the current date, Start Time 
is 15 minutes prior to current time, and Duration default value is 15 minutes.  
 
Duration is a dropdown of time increments from 1 minute to 15 minutes. 

 

 

Figure 8-20: Dropdown of Time Increments 
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 Parameters for Real-Time Status Data Source 
With this option checked, Start Date, Start Time, and Duration are disabled. New status data is 
retrieved by the view and rendered to the main body as updated bands. 

 

 

Figure 8-21: Real-Time Status Data Source 

 View the Time-Space Diagram Graphics 
The main body of the Time-Space Diagram is reserved for the rendered graphics of the green bands. 
It plots the relative distance between intersections and labels the distance and design speed per the 
user-defined link properties across the Y- axis. Along the X-axis is a time scale in seconds. 

 

 

Figure 8-22: Coordinated Phases 

The green, yellow and red duration of the coordinated phases is plotted and colorized on the time-
space diagram. Clearance times are available on Programmed and Historical (MOE) views but may 
not be available on Real-Time Status. 
 
Additionally, users can visualize the split duration of each non-coordinated phase. By hovering over a 
phase label, a tooltip appears that shows the green duration time for that phase. 
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Figure 8-23: Green Duration Time 

Just as distance between intersections is relative to the System Link distance between them, so is the 
slope of the bands according to the design speed of the link. The result of these two features is that 
the arrival of a green band on the next intersection should match real-world conditions, assuming 
actual speed matches design speed. Additionally, the band for the next link segment would visually 
line up if the engineer has designed for maximum throughput. 

 

Figure 8-24: Band progression between intersections 
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 Colors on the Time-Space Diagram graphics 
Forward flow bands are shown in green with a slight transparency. Reverse flow (the opposite 
direction) bands are shown in blue with a slight transparency. The two bands often overlap and are 
shown with a shaded blue-green color. A full accounting of the colors is shown in the following table. 

 

Table 8-1: Time-Space Diagram Colors 

Time-Space Diagram 
colors 

Forward flow bands 
 

 

Reverse flow bands 
 

 

Overlapping bands 
 

 

Yellow change 
 

 

Red clearance  

Split times 
 

 

8.4.2 View Programmed Data 
In this mode, the user can look at the expected performance of a coordination plan on a pre-defined 
route using timing stored on the central server. The user can use the Timing Editor tools to ensure this 
timing data is sent to the intersections before the plan is put into effect. 
 

1. Click the File icon to locate the arterial route. 

2. Double-click the desired arterial route. 

3. Select the “Programmed” Data Source. The parameters 
will change to only show required fields for Programmed 
data. 
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4. Select a pattern. 

5. Click the Update Diagram button. 
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9.  SPECIAL FUNCTIONS 
Special Functions provide ultimate control over signal operations by enabling users to issue specific 
operational commands for a variety of applications. A special function may be simple, as a remote 
detector call or complicated, as a cascade of events triggered by a regional evacuation command. 

9.1 CREATE A SPECIAL FUNCTION 
1. Select: Special Functions > Create Special Function. 

2. Input the general properties necessary to identify the Special Function. 

a. Provide a common Name for the Special Function. 

b. Utilize the Description field to provide more specific details. 

c. Enter the Timeout value which terminates all affiliated 
commands upon expiration. 

 

 

d. Flag the Disable checkbox to disable the Special Function. 

e. Click Next. 

2. Configure the Commands to be associated with the Special Function. 

a. Regional Event (not required) – This field is only utilized by 
Transparity TMS systems that have been regionally 
integrated. When a Special Function is assigned to a Regional 
Event, the Special Function can be initiated without user 
intervention. 

b. Click the Add Command button. 

i. Provide a common name for the command. 

ii. Select one of the available functions. 

iii. Assign the index of the function (for example, if the 
function is “Set Veh Detector Control” the index would 
represent the detector number). 

iv. Select the Target Controller or Group. 

o If the Special Function is intended to be utilized by 
any Controller or Group, use the default setting of 
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“TBD", indicating that the value will be determined 
in the next step. 

v. Select the Control type of the Command (Latch, Momentary, or Auto) 

vi. If desired, enter a time duration for Delay, Extend, and/or Timeout for 
the command. 

vii. Click Finish. 

c. Upon entering the first Command, use the previous steps to create another. 

d. Double click existing Commands, in the command list, to edit. 

e. Click Next when all Commands have been configured. 

3. Assign Connections to the Special Function 

a. Connections enable the user to manage which Controllers 
and/or Groups shall display the Special Function in Real-
Time Displays. 

b. If no Connections are specified, the Special Function will only be accessible 

from the Special Function Interface and/or Special Function Summary. 

4. Click Finish to complete the configuration of the Special Function. 

9.2 EDIT A SPECIAL FUNCTION 
1. Select: Special Functions > Special Functions Summary. 

2. Configured Special Functions can be reviewed within the 
Special Function Summary 

• To edit a Special Function, select the target Special Function 
within the summary list and click the Edit button. 

• To delete a Special Function, select the target Special Function 
within the summary list and click the Delete button. 

9.3 SPECIAL FUNCTION 
Table 9-1: Special Function Properties 

Name A method to identify the Special Function 

Name 
A common name helps users quickly identify the purpose of the Special 
Function. 

Description 
The description can be used to augment the Name field and provide more 
details about the operation of the Special Function. 
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Timeout 
Enables the user to specify a global timeout for the Special Function in 
Hours, Minutes, and Seconds. 

Disable When selected, Transparity TMS will ensure the Special Function cannot 
be executed. 

 

Regional Event 

This option is only utilized in Regional Transparity TMS deployments. 
When a Regional Event is selected, the Special Function and associated 
Commands will execute upon activation of the Regional Event. 

Commands The output of a Special Function is one or more Commands. 

Command Name 
The command name helps users quickly identify the purpose of the 
command output. 

 

 

 

Command Function 

The command function is the control object to be implemented when the 
user and/or system initiates the Special Function Command. For 
example, the name of the Command may be “Manual Control Enable” 
while the function is “Special Function Output”. In this case, the “Manual 
Control Enable” command shall issue a Special Function Output control 
to the target Controller (and the Controller Logic is then utilized to 
implement Manual Control Enable when the Special Function Output is 
active). 

 

Command Target 

The Command Target is the intended destination of the Command. This 
may be a Controller or Group. If the Special Function is intended to be 
utilized by any Controller or Group, use the default setting of "TBD", 
meaning that the value will be determined in the next step. 

 

 

Command Control 

This option allows the user to select how to initialize the Command: 

1. Latch –persistent until the user “un-latches” the command. 

2. Momentary – sets the command active, then immediately deactivates 
the command. 

3. Auto – automatically initiated when the previous command completes. 

Command Delay User-specified duration of time to implement before initiating the 
command. 

Command Extend User-specified duration of time to extend an initiated command. 

Command Timeout 
User-specified duration of time before automatic termination of the 
command. This can be utilized as a failsafe. 

Connections (Group) 
One or more groups for which the Special Function shall appear on Real-
Time Status Displays and group specific menu items. 

Connections (Device) One or more Controllers for which the Special Function shall appear on 
Real- Time Status Displays and Controller specific menu items. 
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10.  SYSTEM ADMINISTRATION 
This section provides an overview of: 

 

• "Current User Information" above 

• "User Management & Security" on the next page 

• "Send User Messages" on page 206 

• "Activity Locks" on page 207 

• "System Processes" on page 208 

• " Resources" on page 208 

• "Options" on page 211 

System administration functions are centrally located in the backstage or System Admin area of 
Transparity TMS. 
 
To access the System Admin section, launch Transparity TMS and click the Transparity 
Settings icon. 

10.1 CURRENT USER INFORMATION 

 
Figure 10-1: Settings Icon 

To quickly return to the main Transparity workspace from the System Admin view, click the Back 
arrow. 
 
From the System Admin area, users with appropriate permission levels can edit or define user access, 
create, or delete users, monitor activity on the account, remove activity locks, check system 
processes, set user access levels, and define security options. 
 
Information about the active user, as well as the version of Transparity TMS that is currently running is 
stored in the Account area. Users may also change their password or sign out from this page. 

 

1. To access the Account area, select: System Admin> Info. 
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Figure 10-2: Current User and System Specifications 

10.2 USER MANAGEMENT & SECURITY 
10.2.1 Manage User Accounts 
 

 
 Creating Users 

1. Select: System Admin > User Management. 

Only users with Manage Users access level may create new user profiles. 
 

 

 

2. Click the Create button on the Access Control page. 
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Figure 10-3: Access Control Create 

3. Use the wizard to walk through adding the necessary data to create a new user. 

4. Complete all required fields in the User Setup screen (see Table 
at "User Setup Properties" below). 

5. Click Next. 

6. Complete all required fields in the Password Setup screen (see 
Table at "Password Set Up" on the next page). 

7. Click Finish. 

10.2.2 User Setup Properties 
Table 10-1: User Setup Properties 

User Setup 

First Name The first name of the new user 

MI The middle initial of the new user 

Last Name The surname of the new user 

E-Mail Address The e-mail address assigned to the new user 

Phone Number The phone number assigned to the new user 

Username The username to be assigned to the new user 
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Access Level 

Access Levels are a system or user defined set of permissions that 
can then be assigned to any user. The access level assigned to the 
new user defines the system functionality the user can access and the 
types of data manipulation that may be performed. 

System default permissions and default access levels are found in 
Tables               "Access Level Permissions" on page 202 and "Default Access 
Levels" on page 204. 

Here are the Default Access Levels: 

 Super User – Highest level of system privilege allowed to a Transparity 
system user. 

Traffic Advanced – Second highest level of system privilege allowed 
to a Transparity system user. 

 Traffic Basic – Third highest level of system privilege allowed to a 
Transparity system user. 

 Traffic Limited – Fourth highest level of system privilege allowed to a 
Transparity system user. 

View Only – Fifth highest level of system privilege allowed to a 
Transparity system user. The new user is allowed Read-Only 
privileges. 

Expiration Date 
A calendar date that may be selected to determine when the user 
account expires and will be disabled. 

Never expire 
Checking this box indicates that the user account should stay active 
indefinitely. 

Inactive A box that can be checked that results in the user account being 
inactivated and unavailable for use until the box is unchecked. 

Password Setup 

 

Username 

This field will be auto populated based on the username entered in 
the previous screen. To update, click the Previous button to go back 
to User Setup. 

New password Enter a temporary password for the new user 

Confirm password Re-enter the password for the new user 

 



Transparity® TMS – User Manual 

Version 1.7.3 Page 201 of 228 

 

 

 

 
 Password Setup 

Table 10-2: Password Setup 

Username First name of the new user. 

New password Enter the new password for the new user. See Password Tips (above) 
for guidelines on generating a new password. 

Confirm password Confirm the new password for the new user 

10.2.3 Reset a User Password 
1. To reset a user password: System Admin > User Management. 

2. Click Reset Password button. 
 

 
OR 
 
1. Right-click the Username of the user requiring the password change. 

2. Click Reset Password. 

3. Enter the new password in the Reset Password window. 
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 Figure 10-4: Reset User Password 

4. Click Reset. 

10.2.4 User Access & Security 
Transparity has a native user database out of the box. However, it also has the ability to authenticate 
against an Active Directory domain so that your credentials come from the system managed by your IT 
department. 
 
By default, Transparity TMS comes with preloaded security/access levels. Transparity comes with a 
set of default Access Levels, each configured with permissions, described below. 

 

Table 10-3: Access Level Permissions 

Permissions Actions 

Set Traffic Controller Manual 
Plans 

Perform "manual override" pattern downloads to a traffic Controller 
(via Send Pattern Command) 

Set Traffic Controller Group 
Manual Plans 

Perform "manual override" pattern downloads to a traffic Controller 
group (via Group Command) 

Set Device Preempts Perform the following functions on a traffic Controller 

• Preempt call (via Intersection Displays) 

 

Set Device Commands 

Perform the following functions on a traffic Controller 

• Vehicle call (via Intersection Displays) 

• Pedestrian call (via Intersection Displays) 

Save Timing to Database Save timing parameters to the central database 

Save Device Timing Perform timing parameter downloads to a device 

Manage Users Add/Edit/Delete Users 
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Manage Traffic Controller 
Groups Add/Edit/Delete Traffic Controller Groups 

Manage Tasks Add/Edit/Delete Service Tasks 

 

 

Manage System 
Configuration 

Edit the following Application Options sections: 

• Devices 

• System 

• Mail 

• Security 

Manage Schedules Add/Edit/Delete Schedules 

Manage Notifications Add/Edit/Delete Event Notifications 

Manage Map Displays Add/Edit/Delete Map Displays 

Manage Intersection Displays Edit Intersection Displays 

Manage Events Add/Edit/Delete Events* 

 

 

Manage Device Configuration 

Add/Edit/Delete the following devices: 

• Traffic Controller 

• Ramp Controller 

• Detector 

• Browsable Device 

Manage Channel Config Add/Edit/Delete Channels 

Manage Arterial Routes Add/Edit/Delete Arterial Routes 

Manage Access Levels Add/Edit/Delete Access Levels 

Import Device Timing Import timing files into Transparity 

Export Device Timing Export timing files from Transparity 

Detector Reset Perform Detector Reset functions on a traffic Controller (via 
Intersection Displays) 

Broadcast Time of Day Perform "Broadcast Time/Date" functions 

* The Event module is currently disabled in v1.0 and v1.1 in Transparity TMS. It is related to 
Notifications by performing tasks based on device status changes, but it can also perform tasks 
beyond sending notification emails, such as pattern downloads or timing audits. 
 
The default access levels are configured with the permissions shown in the table below. 
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Table 10-4: Default Access Levels 

Access 

Level 
Permission 

 

 

 

 

 

 

 

 

 

 

 

Super 
User 

• ManageSystemConfig 

• ManageMapDisplays 

• ManageIntersectionDisplays 

• ManageUsers 

• ManageAccessLevels 

• ManageChannelConfig 

• BroadcastTimeOfDay 

• SetDeviceCommands 

• SetDevicePreempts 

• SetControllerManualPlans 

• ImportDeviceTiming 

• ExportDeviceTiming 

• SaveDeviceTiming 

• SaveDatabaseTiming 

• ManageTrafficControllerGroups 

• SetControllerGroupManualPlans 

• ManageDeviceConfig 

• ManageNotifications 

• ManageTasks 

• ManageSchedules 

• ManageEvents 

• ManageArterialRoutes 

• DetectorReset 
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Traffic 
Advanced 

• ManageSystemConfig 

• ManageMapDisplays 

• ManageIntersectionDisplays 

• ManageChannelConfig 

• BroadcastTimeOfDay 

• SetDeviceCommands 

• SetDevicePreempts 

• SetControllerManualPlans 

• ImportDeviceTiming 

• ExportDeviceTiming 

• SaveDeviceTiming 

• SaveDatabaseTiming 

• ManageTrafficControllerGroups 

• SetControllerGroupManualPlans 

• ManageDeviceConfig 

• ManageNotifications 

• ManageTasks 

• ManageSchedules 

• ManageEvents 

• ManageArterialRoutes 

• DetectorReset 

 

 

 

 

 

Traffic 
Basic 

• ManageMapDisplays 

• ManageIntersectionDisplays 

• BroadcastTimeOfDay 

• SetControllerManualPlans 

• ImportDeviceTiming 

• ExportDeviceTiming 

• SaveDeviceTiming 

• SaveDatabaseTiming 

• ManageTrafficControllerGroups 

• SetControllerGroupManualPlans 
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• ManageDeviceConfig 

• ManageNotifications 

• ManageTasks 

• ManageArterialRoutes 

 
Traffic 
Limited 

• BroadcastTimeOfDay 

• SaveDeviceTiming 

• ManageNotifications 

• ManageTasks 

 

View Only 

No permissions are set for this access level. The default behavior for Transparity TMS is 
to grant viewership rights to unprivileged users, but no configuration management or 
device command privileges. 

 Creating New Access Levels 
Super Users or users with Manage Access Levels permissions can create or adjust access levels for 
all users. 

 

1. Users may also create custom access levels by: System Admin > Access Control 
> Create. 

2. Click the Create button. 

3. Complete the Access Level Properties. 

a. Name. 

b. Description. 

c. Click Next. 

d. Click Add Permissions. 

e. Scroll to the desired Access. 

4. Click Save. 

10.3 SEND USER MESSAGES 
Under the Online Users menu users can send messages to other users on the system. 
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Figure 10-5: Sending Messages to System Users (Chat Feature) 

10.3.1 Send Message 
1. Click on the Send Message button. 

a. A Messenger window will open in the bottom workspace. 

2. Choose the desired User from the dropdown list. 

3. Type the Message in this text box. 

4. Click Send. 

a. The message and reply will appear in the Messenger window. 

10.4 ACTIVITY LOCKS 
The user with Manage System Configuration has permissions to view activity locks that have been 
placed by user activity on the system and can manually remove any that the system did not 
automatically delete. 

Figure 10-6: Activity Locks 

10.4.1 Delete an Activity Lock 
1. Click and highlight the Lock to be deleted. 

2. Click Delete. 
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10.5 SYSTEM PROCESSES 
System Processes provides a snapshot of long-running processes such as responsive routines. Users 
with appropriate permissions can easily select and terminate any active process from this screen. 

Figure 10-7: System Processes 

10.6 RESOURCES 
Resources are a powerful way to capture content maintained by a traffic management center and track 
it within the Transparity TMS solution. A user can attach multiple types of content such as documents, 
geocoded images, or shape files to most objects in Transparity, such as traffic Controllers, system 
links, and subsystem displays. 
 
Administration of Resources is found in the backstage under the gear icon. 

 

  

Figure 10-8: Resources 
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10.6.1 Create a Resource 
To create a resource, navigate either to the backstage Resources page and click Create or 
navigate to the context menu of an object, such as a traffic Controller, and go to Resources > 
Add Reference… followed by clicking the Create button on the resulting Select Resource view. 

 

Figure 10-9: Select Resource View 

Figure 10-10: Create Resource 

 Resource Properties 
Using the context menu of an object, navigate to Resources sub-menu to view or add resources on 
that object. 

 

Table 10-5: Resource Properties 
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Resources 

 

 
Type 

Type can be one of the following: 

• Document 

• Geocoded Image 

• Image 

• Shape File 

• Tru-Traffic Diagram 

 

Shared Regionally 

A checkbox that allows this resource to be synchronized through 
Transparity TDX. This allows things like intersection backgrounds for 
Aerial Display to be shared while preventing more sensitive data from 
being shared. 

Resource 
A file selector specifying the file on disk to upload into the Transparity 
database. 

Description Non-mandatory description of the resource. 

10.6.2 View Resources Attached to an Object 
Using the context menu of an object, navigate to Resources sub-menu to view or add resources on 
that object. 

Figure 10-11: Resources Sub-Context Menu on a Traffic Controller 

10.6.3 Resources Summary for an Object 
Click View All on the Resources sub-menu to view the Resources summary view for that object. 
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Figure 10-12: Resources Summary for a Traffic Controller 

10.7 OPTIONS 
Several menus may be accessed from the Options page. Each one can be accessed by clicking on 
the expand button. 

 

 

Figure 10-13: Options 

10.7.1 Client 
The Client allows the user to set up session timeout times (in minutes) or disable session timeout. 

• If Disable Session Timeout is checked, the user will remain 
logged in until the user physically logs out. 

• Click on the Verify button to verify the Root Server Path, Routing Service Path, 

and Polling Service Path. 

• Click on Save Changes button to save changes. 

10.7.2 System 
The user can edit system settings such as agency name, data path, agency logo and ECcom 
program file path in this section. 
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Figure 10-14: Current System Settings 

10.7.3 Maps 
The latitude, longitude, and zoom level is set for web-based maps. The map opens at the center of 
the latitude and longitude set here as well as at the zoom level. 
 
For GIS maps, set the default coordinate of any imported GIS layers, and select the Shape File that 
corresponds to the Default Coordinate System. 

 

  

Figure 10-15: Current Map Settings 

10.7.4 Devices 
The schedulers check time drift action using the time drift threshold to determine if date/time clock of a 
traffic Controller has drifted. The setting here is the amount of time, in seconds, a clock would be 
allowed to drift before a log and/or an update for the Controller is generated. 
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Figure 10-16: Devices 

10.7.5 Email 
Email server address, port, username, and password are stored here. 
 

 

Figure 10-17: Current Email Settings 

10.7.6 Security 
Preset Security options can be used or the user with security permissions may change the options in 
the area of Username Settings, Password Settings, and Password Expiration (Months). 
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Figure 10-18: User Security Settings 

10.7.7 External Systems 

 

Figure 10-19: External Systems 
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10.7.8 Transparity TDX 

 

Figure 10-20: Transparity TDX 
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11.  CENTER TO CENTER  (C2C)          DATA 
SUBSCRIPTIONS 

This section provides an overview of: 
 

• "TTS Data Subscriptions" on page 218 

• "TMDD Subscriptions" on page 221 

• "Create Bulk TTS PSA Subscriptions" on page 224 

• "Data Subscriptions Summary" on page 224 

McCain Transparity TMS offers multiple ways to share traffic data with external solution providers, 
agencies, and regional DOTs. The first, and most beneficial to most agencies, is Transparity 
Transportation Data Exchange (TDX). This allows agency traffic data to be sent securely and reliably 
to a McCain Transparity TDX web service, where the data is available for the customer’s cloud-hosted 
Signal Performance Measures (SPMs). 
 
For an on-premise deployment, this is often all the customer needs. To support integrations with 
Integrated Corridor Management Systems (ICMS) or other solution providers, the agency data can be 
made available directly from Transparity TDX, not the on-premise server, upon agency approval. The 
advantage with this approach over sharing agency data with external partners directly from the agency 
network, is that the agency’s network firewall rules do not need to be modified to allow more partner 
systems in or out of the network. Keeping an agency’s network surface area as small as possible is a 
critical goal for reducing its exposure to threat actors across the internet, which is why agency IT 
departments uniformly prefer Transparity TDX for enabling external integrations. 
 
A data subscription is a contract to share a certain type of data at a specified frequency with an 
external party. Transparity supports two types of subscriptions: Traffic Management Data Dictionary 
(TMDD) style External Center integrations, and Traffic Technology Services (TTS) Personal Signal 
Assistant (PSA) integration. TMDD subscriptions can be requested at-will by an approved partner 
using a TMDD client for any dialog Transparity supports. This data is then sent at the frequency 
requested to the specified remote External Center service using the Transparity TMDD Subscriptions 
service. The TTS PSA data subscriptions, in contrast, are created by the Transparity TDX 
administrator upon notification of an agreement between TTS and the agency. 
 
The Center to Center (C2C) User Interface (UI) allows the operator to manage Data Subscriptions 
between organizations directly, including the creation of new TMDD and TTS subscriptions. 

1. To bring up the C2C UI, select: Settings Icon  > Options > Transparity TDX. 

2. Select Enable Transparity TDX Communication in the popup box. 

 



Transparity® TMS – User Manual 

Version 1.7.3 Page 217 of 228 

 

 

3. Click Save. 

Figure 11-1: C2C Profile Popup Menu 

4. The C2C menu appears like this: 

Figure 11-2: C2C Menu 

11.1 DASHBOARD MENU 
The C2C Dashboard menu shows the current organizations (centers) in a graphical format. The 
organizations are created using the Admin icon on the C2C UI. 

 

Figure 11-3: C2C Dashboard Menu 

11.2 C2C ADMIN MENU 
The C2C Admin menu offers an Organization Summary screen, Regional Permission Request 
Screen, and Regional Permission Request Summary screen. 
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Figure 11-4: C2C Admin Menu 

11.3 DATA SUBSCRIPTIONS MENU 
The Data Subscriptions menu offers Create Data Subscription, Data Subscription Summary, and 
Create Bulk TTS PSA Subscriptions. 

 

Figure 11-5: Data Subscriptions Menu 

11.3.1 TTS Data Subscriptions 

 Enabling TTS Personal Signal Assistant 
To create TTS data subscriptions, you must enable the TTS integration. Otherwise, options to create 
these subscriptions individually or through the bulk view will be disabled. 

1. To enable TTS Data Subscriptions, select: Settings Icon  > Options > 
External Systems. 

2. Scroll down to the bottom of the popup menu and under TTS 
Personal Signal Assistant, select Enable Personal Signal 
Assistant. 

3. Click Save. 
The Username, Password, and TTS PSA address fields are incorporated into the individual Data 
Subscription records. 
 
Checking the "Enable Personal Signal Assistant" box causes a new Organization for TTS to be 
created. This is viewable on the C2C > Admin > Organizations 
Summary screen. This is the "Requesting Organization" specified on TTS subscriptions. Please do 
not delete this Organization. 



Transparity® TMS – User Manual 

Version 1.7.3 Page 219 of 228 

 

 

 

 
Figure 11-6: TTS Organization Record 

Once this integration is enabled, the TTS PSA subscription type in the Selector menu of a new 
subscription is enabled. 

Figure 11-7: TTS PSA Data Subscription is Enabled 

 Create TTS Data Subscription 
The Create Data Subscription wizard, accessible either via the menu or from the Summary view, has 
two contexts. One is for TTS subscriptions and the other for TMDD subscriptions. Both are very similar 
but with some key differences, described below. 
 

 Figure 11-8: Create TTS Data Subscription 
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On the General page, the Requesting Organization shows TTS selected by default, and the selector 
button is disabled. You are required to select the Target Organization, which is the agency with whom 
you will share traffic data with TTS. 

Figure 11-9: Create TTS Data Subscription - General 

Two types of Response Actions are available. These are the two types of data the subscription module 
acts upon to send to PSA: Traffic Controller Status and Traffic Controller Timing. 

 

Figure 11-10: TTS Data Subscription - Response Action 
The Remote Address will be the TTS PSA endpoint that TTS will provide. 
 
On the Additional page, the operator enters the Username and Password provided by TTS for the 
specified agency. Note that each agency has its own provided credentials. 
 
Enter the start time you wish a Periodic subscription to be fulfilled from. For example, if you have a 
once-a-day Periodic subscription starting at 9:15 am, then that is the time the subscription is fulfilled 
each day. 
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Figure 11-11: Create TTS Data Subscription - Additional 

You may optionally select only some traffic Controllers for the subscription to filter using the Add Items 
on this page. By default, no items in the list means the subscription sends data for all traffic 
Controllers in the system. 

11.3.2 TMDD Subscriptions 
TMDD is a web service (actually a federal USDOT specification), of which McCain has a compliant 
implementation. Transparity supports a handful of web service methods (dialogues) relevant to traffic 
management systems. Two of those dialogs have to do with intersection control - telling intersections 
to implement a specific coordination plan. The first dialog specifies the intersection by device-id, the 
second specifies a group of intersections by group-id. 
 
TMDD subscriptions can be requested at-will by an approved partner using a TMDD client for any 
dialog Transparity supports. This data is then sent at the frequency requested to the specified remote 
External Center service using the Transparity TMDD Subscriptions service.  
 
The TTS PSA data subscriptions, in contrast, are created by the Transparity TDX administrator upon 
notification of an agreement between TTS and the agency. TTS has a requirement that different 
agencies send their data with unique credentials. 
 
TMDD subscriptions are created through requests to any of the Subscription dialogs in the TMDD 
Owner Center Service. They are fulfilled (data is sent) through the TMDD Subscriptions Service. They 
may be created at-will by TMDD clients, such as ICMS partners, for any of the following dialogs: 
 

• Center Active Verification (changes to an Organization, such 
as Organization name). 

• Organization Information (changes to an Organization, such 
as Organization name). 

• Detector Data (updates to periodic volume, occupancy, speed collection). 

• Detector Inventory (new, modified, or removed detectors). 

• Detector Status (updates to detector fault status). 

• Intersection Signal Inventory (new, modified, or removed traffic Controllers). 
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• Intersection Signal Status (updates to traffic Controller status). 

• Intersection Signal Timing Patterns (updates to traffic 
Controller coordination timing). 

• Intersection Signal Control Schedules (updates to traffic Controller TOD 
timing). 

• Section Status (updates to Controller groups, such as name or membership). 

• Section Control Schedules (updates to Set Pattern schedules). 

Aspects of C2C communications include regionally connected systems like the SANDAG RAMS 
network in San Diego County, or the TTS Personal Signal Assistant integration over the cloud using 
Transparity TDX. 

 Create TMDD & TMDD (Caltrans) Data Subscription 
There are the two types of TMDD data subscriptions available: 'TMDD' and 'TMDD (Cal- trans)'. 
'TMDD' refers to a TMDD v3.03d/3.04 compliant interface with support for the dialogs specified in 
the Transparity C2C Interface Control Document. 
 
'TMDD (Caltrans)' refers to a Caltrans-specific Web Services Description Language (WSDL) 
based on TMDD v3.03d/3.04 which redefines the input and output messages on certain dialogs, 
particularly subscription-related ones in the Owner Center and External Center interfaces. The 
Caltrans WSDL also adds some custom elements to certain dialogs. The changes are further 
described in the Caltrans I-210 C2C McCain TMDD 1.2 HLD and SDD documentation for the 
Caltrans I-210 ICMS Pilot Project, scheduled to be completed in Q1 2021. At this time, the only 
deployment of this interface is planned for the City of Pasadena, CA. 
 
On the General page, select the Requesting Organization, i.e. the partner asking for TMDD data, 
and the Target Organization, i.e. the agency whose data has been requested. Select the appropriate 
Response Action based on the partner's request. Remote Address should be the External Center 
endpoint hosted by the partner. This web service must be accessible by the Transparity 
server. 
 

 

Figure 11-12: TMDD Data Subscription - General 

On the Additional page, a user-supplied Subscription Id must be supplied. This value is normally 
generated by the partner's application in the TMDD request message. If you are manually creating a 
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subscription on the partner's behalf, enter a unique value for each subscription. The value is a free 
form text string. The user-supplied Requesting Organization Id is also generated by the partner's 
application in the TMDD request message. This value is not required and is informational only. It is 
also a free form text string. Subscription Information correlates to the information-text field from a 
TMDD subscription's request message. This value is a free form text string and is also not required. 

 

 

Figure 11-13: TMDD Data Subscription - Additional 

You may optionally select only some traffic Controllers for the subscription to filter using the Add Items 
on this page. By default, no items in the list means the subscription sends data for all traffic 
Controllers in the system. 
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11.4 CREATE BULK TTS PSA SUBSCRIPTIONS 
Because the three TTS PSA subscriptions are typically pre-defined, a simple form is provided to 
create the three based on the three pieces of information TTS provides: Username, Password, and 
TTS PSA endpoint. This form is found in the Data Subscription menu. The additional piece of 
information the user must supply is the Target Organization. 

 

Figure 11-14: Create Bulk TTS PSA Subscriptions 

11.5 DATA SUBSCRIPTIONS SUMMARY 
The Data Subscriptions Summary contains the same basic functionality as all summary views in 
Transparity Desktop, including management tools and print features. 

 

 

Figure 11-15: Data Subscriptions Summary 
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APPENDIX A: GLOSSARY 
 

Access Levels The permissions given to users for levels of use and authorization in the 
system 

Added per vehicle Amount of time added when a car passes over an extension detector 

 

 
Adv / Delay Walk 

Advance or delay ped walk phase: 

• Advance – ability to allow ped movement before its associated 
vehicle phase 

• Delay – ability to prevent ped movement for a duration of time 
during associated vehicle phase 

C2C Center-to-center, e.g. server-to-server 

C2F Center-to-field, e.g. communication between a server at city hall and a traffic 
Controller at an intersection 

Central Data Device timing data stored at the central server 

Cond. Service Re-services a compatible phase if demand exists and enough is left over 
from previous phase 

Cond. Service Check Amount of time that must be left on the cycle time for conditional service to 
occur 

DOT Department of Transportation 

DSS Decision support system, typically a vendor solution orchestrating multiple 
systems to support an organization’s decision-making activities 

Dual Entry Will place a call on a phase w/o demand if a compatible phase in the same 
ring receives a call 

EVA Delay/Clear Amount of time a phase will be delayed during preemption and associated 
clearance time exiting preemption 

Field Data Device timing data stored locally at the device 

First Phases Phases go first during startup 

 

Green Band 

A period of phase green time plotted against speed through one or more 
coordinated intersections. Under ideal conditions, green bands between 
intersections would be aligned, allowing drivers to drive continuously without 
stopping through the coordinated corridor. 

ICMS Integrated Corridor Management System, a type of DSS often operated by a 
regional or statewide MPO 

IEN Information Exchange Network (alternative C2C standard) 
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ITS 

Intelligent Transportation Systems, generally describing the segment of the 
transportation industry tackling computational challenges, data distribution, 
and analysis 

Man. Control calls Calls for manual control on selected phases 

Max Gap Amount of time allowed without detection before going to yellow 

Max Initial Maximum amount of green time required before reduction 

 

Max Limit/2 

Maximum amount of green time allotted to a phase. Max 2 can be used as a 

TOD function and can also define the maximum amount of time allowed 
during extension 

Max Recall Places a constant call on a phase to ensure it reaches its MAX green time 

Min Gap Amount of time allowed between detection before gapping out 

Min Recall Places a minimum call on a phase, thereby ensure it always reaches its min 
green time prior to termination, (same as VEH Recall) 

MOE Measure of Effectiveness 

MPO Metropolitan planning organization (e.g. SANDAG) 

 

NTCIP 

National Transportation Communications for Intelligent Transportation 
System Protocol – a family of standards defined by the US DOT for the 
transportation industry, defining a set of common data models for both C2C 
and C2F communications 

PE Min Ped FDW Minimum FDW assigned to Ped movement during preemption 

Ped FDW Amount of time allotted to a ped phase’s flash don’t walk 

Ped recall Places a ped call on assigned phase 

Ped Walk Amount of time allotted to a ped phase before FDW 

Permit Which phases can be serviced 

Red Clear Amount of time allotted to a phase’s red clearance before another phase is 
serviced 

 

Red Lock 

Locks a call when placed on a red phase. This ensures that in places 
where people may creep out of the detection zone (usually to see), their call 
will remain regardless of presence. 

Red Rest Causes a phase to terminate even in the absence of an opposing call. Will 
not work if any recall values are set to this phase 

Reduce Every Amount of time required before reducing by value is applied to extension 
timer 

Rest in Walk Ped phase holds in walk until a call on an opposing phase is made 
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RR-1 Delay/Clear Amount of time a phase will be delayed during preemption and associated 
clearance time exiting preemption 

SANDAG San Diego Association of Governments 

 

SPM 

Signal Performance Measures – a term referring to the reporting solution 
built upon the collection and processing of high-resolution event data logged 
by modern traffic Controllers. 

Soft Recall Places a call on a phase, but does not start max/gap reduction timers on 
other phases unlike the other 3 recall methods 

Time-Space Diagram – a visual display for green band status and manipulation 

TMDD Traffic Management Data Dictionary – a schema of data models for center-
to-center (C2C) communication in ITS applications, defined under NTCIP 
2306 

 

Traffic Adaptive 

A mode of arterial route coordination by which a system responds in near 
real- time to changing traffic conditions, often by manipulating the cycle 
lengths and offsets of running coordinated patterns 

Traffic Responsive A mode of arterial route coordination by which a system responds in near 
real-time to changing traffic conditions by selecting appropriate coordinated 
patterns 

 

Transparity TDX 

Transparity Transportation Data Exchange – a solution deployed and 
typically managed by McCain as a central hub in a star topology which 
facilitates the distribution of agency traffic data from their Transparity TMS 
server to approved partners. 

Transparity TMS  Transparity Traffic Management System – a central software solution used 
by an agency to configure, monitor, and control their network of traffic 
intersections. 

TTS Traffic Technology Services, Inc. 

 
Type 3 Disconnect 

ONLY when type 3 is being used. Type 3 is a detector configuration setting 
used with Quadrupole detectors. A Quadrupole detector is a large detector 
that takes up most of a lane (rectangular). When Type 3 is set to a detector, 
the Quadrupole detector will hold the extension timer until it gaps out. Type 
3 disconnect defines the amount of time to hold the extension timer BEFORE 
it is allowed to gap out 

UDP Universal Datagram Protocol – a connectionless Internet Protocol 

Vehicle Extension Amount of time allotted to the extension timer (counts down to 0) 

VOS Volume, Occupancy, Speed 

 

WSDL 

Web Services Description, the schema used for the most common types of 
web services in the late 90s and 2000’s. It is based on XML and is how US 
DOT C2C standards are described. 
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Yellow Change Amount of time allotted for yellow in any phase. If a value less than 3 or 
greater than 6 is entered, the Controller will automatically use 3 and 6. 

 

Yellow Lock 

Locks a call when placed on a yellow phase. This ensures that vehicles 
stopping at a yellow will be serviced at the next cycle if they go completely 
over the detector. 

Yellow Start Selected phases will be yellow on startup 
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